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Welcome

1 Welcome

Overview

The FAG Detector 111/174) is a vibration measuring device, data collector and
operational balancing device in one. Together with the Trendline 3[187 software,
the device allows improved planning of maintenance and increased machine
availability.

Machine vibrations are a good indicator of a machine's condition. With the aid of
Detector Ill, you can monitor machine vibrations according to ISO 10816 and roller
bearing condition by means of the demodulation detection method. The base
curve and demodulation signals stored in the system can then be used to analyze
the signals in the time and frequency range. This permits detection of alignment
errors and imbalance as reliably as roller bearing damage or gearing problems.
Other process parameters that can be recorded are temperature and rotational
speed.

Applications

Measuring and analyzing machine condition

The FAG Detector Ill records vibration signals at pre-defined measuring points by
means of a sensor and then calculates the effective values for velocity,
acceleration and demodulation. These characteristic values| 151 describe the
condition of the machine and component.

You can define and monitor frequency bands of any frequency width in the range
from 0.1 Hz to 20 kHz. FAG Detector Ill can save up to 1600 measuring points and
up to 270 time signals. Once a measuring round has been finished, all data
recorded are transferred to the Trendline software, where they are evaluated,
analyzed and displayed.
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Balancing with the Detector Ill (available as accessory function)

There are many and diverse reasons for unscheduled machine standstills.
However, a considerable number of these is due, directly or indirectly, to
imbalance or alignment errors. During operation, imbalance may cause severe
vibrations, that can lead to consequential damage, for example premature bearing
wear or fatigue-induced breaks. The result is machine failure and thus
unscheduled production downtime.

The FAG Detector lll is a tool with which you can not only detect but also remedy
such conditions easily and efficiently. The easy user interface provides good
support during the balancing process. Step by step, the device software guides the
user through the balancing process. The user can create a configuration for each
balancing process with the Trendline software. Furthermore, he can define
templates that can be adapted on site on the machine. The balancing results are
sent to the Trendline software. You can display them there in table form or as a
diagram.

Analyzing data with the Trendline bearing database

The integrated bearing database (approx. 20,000 bearings from various
manufacturers) simplifies and speeds up analysis of measured data in
combination with the FIS-Viewer|1141. It allows you to detect any irregularities at
first glance and assign the appropriate components. You can save multiple
bearings per measuring point. This allows you to check multiple bearing ball-pass
frequencies at a measuring point. Every user can add new entries to the bearing
database to suit individual needs.
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2 General

2.1 About this documentation

This documentation describes the functionality of the Detector Il and the Trendline
software. It explains:

e how to create configurations| 42 or measuring routes/ 821 on a computer and
transfer these to the Detector;

e how to use the device to record measuring data;
¢ how to transfer data from the Detector to the computer and
e how data can be analyzed and stored.

The appendix also contains an introduction to the basic principles of vibration
monitoring 2161 and a brief description of the subject "Temperature measurement
with the Detector II1/2161".

Safety information symbols

DANGER Safety symbol

A This safety symbol warns you of material damage and dangers to
health, life-threatening injuries and death.

General information symbols

This symbol indicates
g‘f e helpful additional information and

e device settings or application tips that help you perform tasks
more efficiently.

Cross-reference symbol| 9": This symbol indicates a page in the manual with more
detailed information. If you are reading the manual on screen in PDF format, you
can jump to this page by clicking the word to the left of the cross-reference symbol.

2.2 Mode of functioning

Detector Il is a hand-held measuring instrument with data recording function for
offline monitoring of systems and machinery (condition monitoring). For this
purpose, the instrument senses vibrations at pre-determined measuring points
using a detector and works out the RMS values of vibration velocity, acceleration
in vibration and demodulation, the so-called characteristic values, for
characterizing machine or component condition. In addition, Detector can measure

9
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temperatures using an infra-red sensor.

Once a measuring round is finished, the measured characteristic values and any
recorded time signals are transferred to a computer where they are evaluated,
analyzed and graphically depicted using the Trendline software | 18"

The exact location of the measuring point within the system to be monitored is
stored in the configuration|42". There, the sensor sensitivity for each measuring
point and the threshold values for main or preliminary alarm are stored as well.
The configuration is created using the Trendline software! 187 and transferred to
the Detector prior to measuring.

For measuring, the vibration sensor is fixed to a pre-determined measuring point
with the help of a magnet footing. If this is not possible due to the housing
material (e.g. aluminum), attach an iron plate or a washer the size of the
magnetic at the measuring point. This is easiest done with the help of a fast-
curing superglue (e.g. cyan acrylate glue).

The configuration of the measuring point is selected on the Detector and the
measuring started. Detector records the sensor signals broadband and works
out the characteristic values. These characteristic values are stored and
transferred to the computer once the measuring round is finished.

For each measuring point, the newly measured characteristic values are
compared with the threshold values determined for this measuring point for a
main alarm and pre-alarm. The Detector (main alarms) and the Trendline
software (main and pre-alarms) display the threshold events. New characteristic
values are stored. You can depict them graphically in the Trendline software
depending on time of measuring.

In addition to the condition monitoring measurement (subsequently referred to as
CM measurement/182)) the Detector Ill also masters what is known as operation
balancing. During this process the Detector helps you find the optimum position of
balancing weights when carrying out the balancing measurement|189l. These
weights serve to compensate for imbalances in rotating parts and therefore extend
their service life.

10
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Before you start

Ferrit modules will reduce electromagnetic fields from the device which could
otherwise affect other electronic devices in the vicinity.

You will receive three ferromagnetic modules with the RFID-Kit or the
RFID-Detector. The ferrit modules have to be fasten to the three sensor cables
(cable for the acceleration sensors as well as for the trigger sensor) of the
Detector.

Ferrit module

Proceed as follows:
1. Put the sensor cable into the groove of the ferrit.

2. Adjust the cable so that the rim of the ferrit modul is placed addording to the
picture. Please note that the ferrit module should be placed as close as possible
to the Detector.

3. Close the retractable ferrit module enclosing the cable firmly till it engages.

Ferrits fasten at the sensor cables

11
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2.3 Intended use

Disposal information

Neither the Detector not the associated components may be disposed of via
domestic waste as they contain electronic components and NiMH accumulators
that must be disposed of in the proper manner. Please return them to us so that
we can ensure disposal in keeping with legal and environmental requirements.
Returning used devices is an important contribution to environmental protection.

Information to the user

Changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the
interference at his own expense.

Industry Canada
This Class A digital apparatus complies with Canadian ICES-003.

12



2.4 Scope of delivery

DETECT3-KIT

e Base unit with accumulator

¢ Accelerometer with magnetic foot

¢ Infrared temperature sensor

o Battery charger with travel adapter

e PC data cable (serial/lUSB)

e Manual

e Protective bag with temperature sensor holder
e Trendline PC software

e Case

General

13
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DETECT3.BALANCE-KIT

14

Acceleration sensor with magnetic foot and sensor cable
Trigger sensor (optical and inductive)

Scales

Magnetic holder for trigger sensor

Extension stick for magnetic holder

Cable for trigger sensor (length 10 m)

Reflex mark for optical trigger sensor

Dongle for activating the balancing function

Case
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RFID KIT

e Base unit with accumulator and RFID reader
e 5 RFID tags

e Accelerometer with magnetic foot

¢ Infrared temperature sensor

e Battery charger with travel adapter

e PC data cable (serial/lUSB)

e Manual

e Protective bag with temperature sensor holder
e Trendline PC software

e Case

Accessories

Sensor extension cable (5m and 15m length), sensor bases and rail magnet
available on request.

2.5 Characteristic values

Detector Ill can store up to 4 different (or same just as well) characteristic values
per measuring point. The following characteristic values can be selected:

Charac- |Meaning
teristic
value

ISO 10816 | RMS value of vibration velocity
Frequency range: 10 Hz to 1 kHz
Unit: mm/s

RMS value of vibration velocity with freely selectable upper and lower limiting frequency
Frequency range: 0.3 Hz to 20 kHz (depending on the lowpass frequency)
Unit: mm/s

sel

RMS value of acceleration in vibration
Frequency range: 2 Hz to 20 kHz (depending on the lowpass frequency)
Unit: g

Aatf

RMS value of acceleration in vibration with freely selectable upper and lower limiting frequency
Frequency range: 0.1 Hz to 20 kHz (depending on the lowpass frequency)
Unit: g

sel

Demodulation signal of acceleration in vibration with switchable low-pass
Frequency range: 0.1 Hz to 20 kHz (depending on the lowpass frequency)
Unit: g

deff

dsel RMS value of demodulation in vibration with freely selectable upper and lower limiting frequency
Frequency range: 0.1 Hz to 20 kHz (depending on the lowpass frequency)

15
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Charac- |Meaning
teristic
value
Unit: g
T Temperature
Range: -20°C to +550°C
Unit: °C
Crest factor | Ratio between peak value and RMS value (Crest factor = peak value / RMS value)

In addition to the aforementioned characteristic values, you can
g also measure rotational speed.

16
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2.6 Statement of Conformance to electrical safety and EMI
requirements

Declaration of conformity as per the Radio and Telecommunication
Transmitter Devices Act (FTEG) and Directive 1999/5/EC (R&TTE)

The manufacturer: F'IS, FAG Industrial Services GmbH
KaiserstraBe 100
D-52134 Herzogenrath Germany

declares that the product: Detector lll
Radio installation

Purpose: RFID application
Device category: Category 1

corresponds to the basic requirements of §3 and the other relevant provisions of
FTEG (article 3 of R&TTE) if used for the intended purpose.

Health and safety as per § 3 (1) 1. (article 3 (1) a))

Harmonised standards used: EN 60950-1: 2001, EN 50364: 2001
Protection requirements with regard to EMC § 3 (1) 2, article 3 (1) b))
Harmonised standards applied: ETSI EN 301 489-3 V1.4.1

Measures for efficient use of the radio frequency spectrum
Harmonised standards applied: ETSI EN 300 330-2 V1.3.1.

This statement of conformance is issued based on testing the EMC aspects of a
representative product sample of the above mentioned product in conformance
with the following standards:

ETSI EN 301 489 ETSI EN 300 330 EN 61000-6-2
EN 61000-6-4 EN 60950-1 FCC Part 15

Measuring device identifier: CE

Herzogenrath, 22.06.2007

e,

/{ "f —?,5-_" ,:"J / IKLFF_; -
Dr.-Ing. Bernd Ger:‘:lp ‘,;a i.V. Dipl.- ng'_.r"Gﬁtz Langer
Geschéftefiihrer Entwick} r}g?.'-:lﬂit-_:rr
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3 Trendline 3

The Trendline software is the server-based program for the Detectorlll. The
Detector itself is designed only for the recording of measured values. All data
organization and evaluation tasks are carried out by the Trendline software.

The monitoring of a system is configured using the software which also evaluates,
analyses, and stores the measuring data delivered by the Detector.

Further, Trendline 3 manages the exchange of data between the server on which
the software is running and the Detector.

3.1 Program installation

In addition to the application program, the Trendline software requires the MSDE
database server. It must be installed either on the local computer or on a network
server. If you are already using an MSDE database server, you can register the
databases with this.

Please note that you need Administrator permissions for your

g' computer to install the Trendline software completely. If you do not
have these permissions, ask your system administrator. For
example, you can install the software with Administrator
permissions and then switch back to a normal user.

3.1.1 System requirements

In order to use the Trendline software in an optimum way, the following minimum
requirements must be met:

General system requirements

e Pentium Il PC with 500 MHZ (recommended: 1 GHz)
e atleast 512 MB RAM (recommended: 1 GB)

e Screen resolution: 1024x768 (pixels)

Operating systems
e with MSDE 2000: Windows 2000, Windows Server 2003, Windows XP

Please note that the Trendline software does not yet run on
Windows Vista.

Hard disk memory for installing the Trendline software

e Trendline software 3.2 (without database and database server): 62 MB

18
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e Detector Flash Updater: 4 MB
e Demo database and bearing database: 20 MB

Hard disk memory for installing the database server
e MSDE 2000: 50 MB

Hard disk memory for the database
e MSDE 2000: at least 2 GB (recommended: 6 GB)

Other requirements
e Microsoft Internet Explorer 6.0 SP1 or later

3.1.2 Trendline software installation

Please insert the Installation CD. If you do not have a CD, you can download the
current version of Trendline from our website (www.fis-services.de).

If the installation program does not start automatically you can start it manually
using Windows Explorer:

1. Open My computer.

2. Under Equipment with removable media click the right-hand mouse button on
the CD-ROM drive then click Open.

3. Start the Trendline installation file (Trendline-Setup-3.2.exe) by doubleclicking
on it.

4. Please select the language to install the Trendline software. You can change the
language settings|110) at any time after installing.

The Setup Wizard guides you through the rest of the installation:

19
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| Setup - Trenalline 3.2 Y fu
Welcome to the Trendline 3.2
Selup Wizord

Thes ol melall Tieredres 320 v pana compud si.
I & e il wmae chose &l olles sppbcslens Lelos
[k, blemdd lor cortines. o Carvoad bo mol S elup

-'71 Selup - Tresulline 3.2

Srlert Deatimatsnn | neakinm
\where should Tionding 3.2 be instalod? "T

,-'_J Setup wil instal Trandine 3.2 info the followang foider.
T g, chok Nesl, 11 i v e b sebecd  diterand |okde, chk Bigvee,

jl:"'.Fm[l.:In Files\FIShTiencine 2.2 Bpowre.. I

Ablnnat SEE MB of fren disk spann i sequined

cgisck | Mews | coca |

6. Select the Start menu directory to create the program link. Click on Continue.

20
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|E1 Selup - Tresalline 3.2 ﬂﬂ
Selent Siart Mero Falder ==
w'hene ahould Sehip place the progiam’s sholcuts? "T

Setup vwil casate He priogram’s ehortcase in tha felliovang Stark Miemu iolde:

T srtrnm, chch, Nmal. 11 you wonshd Bhos o selecd & difemant |oidei, chk Biowee,

|[FiS\Tiendine 3.2 Bpovee... j

7. Optionally, you can select other components of the Trendline software to install.
To do so, check the checkbox next to the option

a) Flash Updater to update the Detector firmware [208)

b) Database installations to install the demo database and/or bearing database
and click Continue.

-L:l Selup - Trevslline 3.2 .-J.]l.i’ﬂ
Salent Additionad Tasks Sy
\which addeional lasks should bs perfomed? ,-;-..

Sednel the addditional sk pou vould Bus Seup in perfoom whils meinling Tieedine 32
theen chel Himd

Flaars pulect oileorial sebup pals
¥ Nath Updsler [Pregram lo uedate the Dalecha sollwe|
¥ Darshase natallsnons [Dema datshase ¢ Beang datshase)

21



W fils

Please note that the Trendline software requires MSDE (Microsoft
SQL Server 2000 Desktop Engine)!

8. In the next window check your settings and click Install or Back to correct your
settings.

This installs the Trendline software.

3.1.3 Detector Flash Updater installation

If you selected Flash Updater when you installed the Trendline software, the
Setup Wizard automatically starts installation:

ol

Welcome to the Derector Flash
Updater 3 Sctup Wizard

Tz vl wrelall Dotmclin Flagh U pdsben 3 o o covigrlen,

L5 neconnersded thal wou chose 8l olbey appbcalions befos
conlEnrg

Cck, Mot Mo ciortirmas. o Carresd Lo sl Selup

1. Select the directory where you want to install the software and click Next.
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|L';1 Selup - Deleclur Flash Upndater 3

Selent Deatimation | neakinn
‘where ahould Detocion Flash Updater 3 be rolaled?
_"J Setup wil inctal Detecton Flach Updaier 3 inio the foowing foider.

T cunbrnse, choh Nesel. 1 you woid o o celect @ Gifevend ok, clok Biowse.
| \Program Fies\FIS\D etectorFlashUindater3 Bpovee... |

Aot 3.8 MR of e dik s it anquinsd

cfisck | Mews | coca |

2. Optionally, you can add program icons on the desktop or to the quick launch
bar. To do so, check the checkbox next to the option

a) Create a desktop icon to add a shortcut on your desktop

b) Create a Quick Launch icon to add a symbol to the Quick Launch bar next
to the Start button

and click on Next.

:'E. Selyp - Deleclor Flash Updaler 3

Celent Additicnal Tazks
wihich additona laska should be peilomed?

Sednct the addiional tazhs wou wild Bue Sesup i perfioem whils irctaling Dwinctor Flash
Lipcstes 3. then click Mes

Fubdaoidl s
¥ Creste a desklop icon
[ Craste & Quack Launch icon

3. In the next window check your settings and click Next to install the Detector
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Flash Updater or Back to correct your settings.
This installs the Detector Flash Updater.

3.1.4 MSDE installation
If you selected Database installation when you installed the Trendline software,

the Setup Wizard automatically starts installation:

Selup - Trenwline Dalabases 3.2 .I' Iﬁl

Welcome to the Trendline
Databases 3.2 Selup Wizord

Thes vl wislall Tieradires D alabosses: 3210 on wmna congale,

I & pecmerersded hel vou close sl dbes applcations befons
Gurdrmarg

Clck, Momat o coortrmas. or Carrcd Lo sl Selup

1. Please select whether you want to
a) install MSDE and register database,
b) only install MSDE or
c) register databases with an existing MSDE/SQL server
and click Continue.
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:'E. Selup - Trenulline Dalalbases 3.2

Micrnendt SOL Sererr 2000 Deakinp Fngine [MS0E)
‘whoukd pou Bue to irstal the MSDE and databases?

% Inatall Bhe Microsoft 50U Server Dieskiop Engine snd iegister the dalabases,
{ Inaaall MSDE anky

(" Regete databeses on MSDE / M5S0 Sereer

If you selected Register databases with MSDE/SQL server, please continue
with registration | 27,

2. Select the directory in which you want to install the database server. Click on
Continue.

B Selup - Tresuline Dalalbases 3.2

Mirrnznlt SO Sererr 2000 Deakinp Fngine [HMS0F)
Pleass sedsct MSDE install deecionies

MEDE sxeculable drschooy
|C:\Program Files\mide\bin

3. Select the directory in which you want to install the MSDE database. Click on
Continue.
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fE. Selup - Trenulline Dalalbases 3.2

Micrnendt SOL Sererr 2000 Deakinp Fngine [MS0E)
Fleass seloct MSDE install deecionies

vigh fmrpsm

MSOIE dats deschons
|C:\Program Files\mide'\dara

4. Optionally, you can select additional databases to install. To do so, check the
checkbox next to the option

a) bearing database/ 68" to install the most common bearings in a database
b) demo Trendline database to install a database with demo data
and click Continue.

|'E. Selup - Tresulline Dalalbases 3.2

Geleet Additicona Tazks
Wwihich addisonal lazks should be peilomed?

Sednct the addiional ks pou would Bos Sesup in perfioem vwhis relaling Terdine
Bakaboans 32, then click e

Flaass pabect B el sbaes i wan Lo melsll
¥ Desrg delsbase
¥ Trending demo datsbase

This installs the Microsoft SQL Server 2000 Desktop Engine (MSDE) with the
selected databases.
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5. Click Finish to close the Setup Wizard.

3.1.4.1 Registering databases at the MSDE/SQL server

If you selected Register databases with the MSDE/SQL server, you must
connect the databases (Trendline and bearing database) to the MSDE/SQL server:

Registering Trendline databases at the MSDE/SQL server

1. Select the database server that contains the database from the server list or
enter the server in the input field in the upper area of the window. Click on
Refresh to display the list of available servers.

If you do not find any entries in the server list due to restricted user
4 permissions, enter "Computer name\FIS_DATABASE" manually (if
5 the name of your computer, for example, is "peters laptop”, the
server name would be "peters_laptop\FIS_DATABASE"). You can
find your computer's name in the Windows Explorer drives. If you
are not sure about your computer's name, ask your administrator.

2. Select Use a specific user name and password and enter your user name
and password to log-on to the database. If you select a database server that
was installed during a Trendline installation (contains FIS_DATABASE in its
name), the user name is sa and the password is sql8. Make sure to enable
Allow Password Save to save the password.
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x|
Provider Connection | Advanced | A1 |

Speescaly e |olovereg o Gormect, 10 SUL Ferner data
1. Sefect or enler a sprer name:
|FEEIH31H'-FIE_E'.-"|T."'.B:'-.5E j I'I':llnhl
2 Embry infonmabion In kog om ta e sereer
= Lgs Windows NT Irtegiated securie
% Upe & spacific user naeme and padewond:

e s |:-:

o iwaid |-n--

™ Blark pareod  [F Adow gavmg pasmwend
30 Eplect the datnbnae on thee serven

Iumln d

™ Anach a databade file a2 & dalahsces name:

| |

3. Select the database master from the list.
4. Click on OK.

Registering a bearing database at the MSDE/SQL server

1. Select the database server that contains the database from the server list or
enter the server in the input field in the upper area of the window. Click on
Refresh to display the list of available servers.

If you do not find any entries in the server list due to restricted user
: permissions, enter "Computer name\FIS_DATABASE" manually (if
Q/ the name of your computer, for example, is "peters laptop”, the
server name would be "peters laptop\FIS_ DATABASE"). You can
find your computer's name in the Windows Explorer drives. If you

are not sure about your computer's name, ask your administrator.

2. Select Use a specific user name and password and enter your user name
and password to log-on to the database. If you select a database server that
was installed during a Trendline installation (contains FIS_DATABASE in its
name), the user name is sa and the password is sql8. Make sure to enable
Allow Password Save to save the password.
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Provider Connection | Advanced | A1 |

Speescaly e |olovereg o Gormect, 10 SUL Ferner data
1. Sedect or enier & 3prer nome:
|POSOSE31 915 _DATABASE =] Retiesh |
2 Embry infonmabion In kog om ta e sereer
™ Upe Windows NT Ireegated securte
% Upe & spacific user naeme and padewond:

e s |sa
Pariwond |---I

™ Blark pareod  [F Adow gavmg pasmwend
30 Eplect the datnbnae on thee serven

Iumln d

™ Anach a databade file a2 & dalahsces name:

|' |

3. Select the database master from the list.

4. Click on OK.

Trendline 3

If you want to register the database later on, please select
g/ bearingDB instead of masterDB.

3.1.5 Uninstalling

To uninstall the Trendline software, please click Programs > FIS > Trendline 3.2
Uninstall Trendline in the Start menu. This uninstalls the Trendline software and

its components.

Please note that configuration and export files are left on your computer. For your
safety, the database is not deleted either. To completely uninstall, you must delete
these files manually.
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3.2 User interface
3.2.1 Main window

The layout of the main Trendline 3 software window is based on standards which
have developed for user interfaces in the meantime.
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At the top edge of the main window you will find the menu bar! 31, where you can
call up the functions of the program via the menu items. Frequently used functions
can also be activated using the buttons in the toolbar! 33".

On the left-hand side of the window the structure of the configuration for the
system to be monitored is depicted in the form of a directory tree. The
“Configurations”, which are splitting in descending order into the levels “Section”,
“Machine” and “Measuring Point”, are the highest classification element. That way,
a measuring point within a configuration is clearly defined by it's denomination as
well as the specification and location of the machine the measuring place is to be
found at.

Next to the denomination of each element of the configuration and system
structure you will find a field marked in color. It indicates the alarm condition for
this part of the system following the table below.
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Color

Meaning

For this level of the system structure no alarm is recorded.

For this level of the system structure preliminary alarm is recorded.

For this level of the system structure main alarm is recorded.

-EE An RFID tag has been assigned to this measuring point.
A An RFID tag in this part of the system has been marked as defective.

On the right-hand side next to the configuration and system structure you can
insert an image. At the highest level you will find the tabsheets, where you can
adjust the settings of the individual measuring points.

The dividing line between the image of the configuration and system structure can
be shifted towards the right or left by dragging with the mouse.

In the configuration structure, always one element is marked. The
properties of this element are depicted in the right-hand part of the

window.

3.2.2 Menu bar

The menu bar allows access to the following functions of the Trendline 3 software:

Menu Menu items and their functions
File New Creates a new database.
Open Opens an existing database.
Import Loads records exported with Trendline.
Export Exports part of a current measuring point structure using the export wizard
105 or export a single measuring point [ 1061,
Recently used Trendline displays recently used databases at tr’ﬂi%oint in the menu. You
databases can specify the number in the program settings 111,
Close Quits the Trendline software.
System To root level Takes you from your current position in the tree right back to the
beginning, all the time.
Rename Rename currently selected element.
New item Inserts an element of the configuration structure in the same level as
currently displayed.
New subitem Inserts an element of the configuration structure in the level below the
current.
Add balancin% 534 |Inserts a balancing configuration.
configuration | 53
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Menu Menu items and their functions
Add run up/coast | Creates a run up/coast down configuration.
down configuration
61
Expand selection Flaps up all elements under the current element.
Collapse selection | Closes the complete tree structure.
Cut Cuts out the current element of the tree.
Copy Copies the current element of the tree.
Paste Pastes the element on the clipboard into the current position in the tree.
This is only possible in the tree level above that of the copied element, e.
g. when copying a machine, this can only be pasted into the plant level of
the tree.
Delete entry Deletes the current entry at the tree with all sub-entries.
Delete measured | Deletes measured data from the current position.
datal 934
Reset alarm status | Reset all alarms for the element of the configuration and system structure
KZa selected.
Adjust alarm levels | Automatic adjustment of the alarm levels.
o
Detector Send configuration | Send all measuring points from currently selected element downwards to
detector.
Send route Sends one of the pre-selected routes to the detector.
Load data from Opens a connection to the detector and downloads all data stored in the
Detector detector.
Configure Detector | Allows to set all options to the detectors registered.
Balancing activation | Enables the balancing function on the Detector.
| 38"
Sensor Adds| 344, edits and deletes sensors.
Comment selection | Create and edit a list of comments.
list| 52
Planning Route Creates out and edits routes.
Template Defines and edits configuration templates that can be used for ad-lib.
measurements.
Service EService Sends selected data for further analysis.
Measurement report | Creates a measurement report.
| 96
Alarm Report Creates an alarm report.
Route report Creates a route report.
Balancing report Creates a balancing report.
Run up/coast down | Creates a run up/coast down report.
Report
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Menu Menu items and their functions
Tools Options Program settings
Bearing DB Opens the bearing database | 68",
? Contents Contents of the online help.
Index Search index for the online help.
First steps Start using the Trendline Software.
Menu bar Explains all menus of the Trendline Software.
Toolbar Explains all icons in the toolbar.
About Trendline Information about the Trendline Software.

3.2.3 Toolbar

Frequently used functions of Trendline software can be used via the toolbar.

"
Toolbar
IE Go to root element Paste
I:l Create new item }( Delete
L7 Create new sub-item ::I Reset Alarm Status
@ Add balancing configuration Send configuration to detector
Add run up/coast down configuration Send route to detector
Ea- Expand tree entries Download data from detector
=W Close selected element .é Alarm Report
% Cut EService

Copy
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3.3 First steps
3.3.1 Adding a sensor

Before you can set up configurations, you must define the sensors you want to
use. Detector Il is delivered with all necessary sensors. They are pre-defined in
the Trendline software.

Proceed as follows to add new sensors:

¢ In the Detector menu click Sensor > Add.

¢ In Sensor type choose from Acceleration, Temperature or Trigger sensor.
¢ In the Name field, enter a name for the sensor, e.g. "IMI 627".

Acceleration sensor

Add sensor !

Sengar lype

{+ Acceleration sensor " Temperature sensor " Trigger sensor

Mame

Activ 100 miAg [CTC ACT02)

Data
S engitivity tin allowed biaz tax allowed biaz
| 100 m /g v Active sensor 5 |1 7

Help |

e Enter sensor sensitivity in mV/g in the Sensitivity field. Sensitivity is printed on
the sensor or indicated in the enclosed specifications.

e When you add an active sensor, select Active sensor and enter minimum and
maximum bias voltage in the appropriate input boxes. On the one hand, this
activates sensor supply voltage in the Detector before the measurement is
performed and activates a high pass to filter the supply voltage out of the
measuring signal. On the other hand, the Detector checks whether sensor bias
voltage is within the set thresholds. Minimum bias voltage must be at least 3,
maximum bias voltage must not be greater than 17. The difference between the
two values must not be less than 10.
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If you want to measure on a power supply unit, Active sensor must
not be enabled.

e Click OK to save the new sensor.

Temperature sensor

Add sensor

Sengor lype

" Acceleration sensor i+ Temperature sensor = Trigger sensor

M arme

R avnger [P-b

Drata

Sengtivity Offzet
| 100w/ | x| | 0 iy

Help |

e Enter sensor sensitivity in mV/°C, mV/°F or mV/K and the offset in mV.
¢ Click OK to save the new sensor.

Trigger sensor

The trigger sensor serves to measure rotational speed and is used in operational
balancing to start the measurement/18%),
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Sengor lype

" Acceleration sensor " Temperature sensor f* Trigger sensor

M arme

|I:I|:|ti|:al [B anner kMinibeam St3120% 00

Data
Supply voltage:

I exterm - I

Help |

e Select the Supply voltage: External, 5V, 12V.
e Click OK to save the new sensor.

3.3.2 Installing USB-serial converter

A USB serial adapter is supplied with the Detector which you can use to connect
the Detector to computers with USB interfaces.

When installing the adapter software make sure you have the adapter and the
installation CD provided to hand.

Installation of the adapter software
To install the adapter software proceed as follows:
¢ Insert the supplied CD. The installation program should start automatically.

If the installation program does not start automatically you can start it manually
using Windows Explorer:

1. Open My computer.

2. Under Equipment with removable media click the right-hand mouse button on
the CD-ROM drive then click Open.

3. Double click to launch autorun.exe.
4. At USB TO RS232 Converter, click the folder icon next to Product Driver.
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5. Select the win_98se_me_2000_xp folder.
6. Click on Setup.exe.
This launches the installation wizard which guides you through the installation.

If you are already using other devices that use a Prolific USB to
E/ Serial chip, please uninstall the drivers for the old devices first as
this may result in conflicts.

Checking serial interface settings

To make sure that communication between the Trendline software and the
Detector works smoothly, you can check the USB serial adapter settings for the
serial interface:

1. Click the right mouse button on My computer then click on Properties.

2. Click Hardware then Device manager. The adapter should be displayed as
"Prolific USB-to-Serial Bridge" under Connections (COM and LPT).
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3. Close the Device manager.

Removing the adapter software

The adapter software can be removed as follows:

1. Click on Start, click on Control panel and then click on Software.

2. Click on Modify or remove program then click on PL-2303-USB-to-Serial.
3. Click on Modify/remove to uninstall the software.

3.3.3 Balancing activation

The Detector Il is supplied ex works with the balancing functionality switched off.
You can enable this function if you have purchased a Detector Il balancing kit.

The balancing kit contains a USB dongle which can be used to enable one unit
only.

Dongle

This activation is essentially carried out as follows:
e A dongle is supplied with the balancing kit that has not previously been used.

e You can use this dongle to enable the balancing functionality for only one
Detector which can be selected at will.

e Once enabled, the serial number of the Detector is saved on the dongle. From
this point onwards the dongle may only be used with this specific Detector.

e You can also deactivate the balancing functionality in the Detector once again
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using the corresponding dongle. The serial number on the dongle is then
deleted and you can now use it to enable any other Detector of your choice. This
is useful, for example, if you are sending a Detector to the manufacturer for
calibration and want to use the balancing function on a different Detector in the
meantime.

To activate the balancing function on the Detector, start the Trendline software.
Connect the Detector to the PC using the serial cable. Plug the dongle into a free
USB port. Switch on the Detector and select the Trendline menu item Detector >
balancing activation. The following window is now displayed:

"'*':’.E'.‘_Balancing activation i =10 x|

Connected Detector

et connected Detector | IE'-'I 004/F3

Dongles attached to thiz computer

Refresh dongle list |

Kind | erzion | Ized for Detector: |
LSB 2000 B10004/F3

Aotivate balancing fon connected [etectar I

Deactivate balancing for connected Detectar I

Cloze |

The serial number of the connected Detector and the dongle identified are
displayed at the top and bottom respectively. The identified version should start
with "3" in the case of Detector Ill. The serial number of the Detector for which this
dongle has already been used or, if the dongle has not yet been used, <Empty> is
displayed in the Used for Detector: column. Now select the required dongle from
the Type column (should be displayed as "<Empty>" in the "Used for Detector"
column). You can now enable the balancing functionality via Activate balancing
for connected Detector. A new line Balancing should now be visible and the
serial number of the Detector is displayed in the dongle line.
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. e The first time the dongle is used Windows detects the driver that
g’ was previously installed with the Trendline software. If Windows
asks for a driver select the automatic search option.

e If the dongle is not displayed or a previously used dongle
appears in the list, please click Refresh dongle list.

e If the dongle is correctly identified by Windows but this is not
displayed in the Trendline dongle list you may have an old driver
installed on your system. You can check this in the device
manager under USB controller -> CBUSB Ver 2.0. If Version 1.x
is displayed, uninstall this driver and install the up-to-date driver
on the Trendline CD in the CbSetup directory. In this case select
the CRYPTO-BOX USB.

3.3.4 Register new detector

The Trendline software holds a database for administrating all detectors you use
with your program. Prior to sending data to the Detector for the first time, it has to
be registered to Trendline software. To do that, you connect the Detector to a
serial interface of your computer using the data cable supplied and switch on the
Detector.

The Detector which has just been connected to the computer is

g' normally automatically detected by the system and registration of
this is not compulsory.

How to register a new Detector:
e Click on Detector > Configure Detector.
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Configure Detector

Serial number

I G10004/F3 j Search far new Detectar |

M ame
|F'IS

Language

| Engiish =l

[Date / Time

|4.-’2E£2EIEI? 5 06: 29 Prd v Send system date to the Detectar

Baud rate

57600 -~

Help |

Connect the Detector to your PC and switch it on. Click on Search for new
Detector to register the new Detector on to the program.

You may give the Detector a name, which will be displayed in the default display
when switching on the instrument.

You can select the language for the Detector. Nevertheless it still can be
changed at the Detector.

You can set the time of the Detector either by entering the correct time and date
(to do this, click on the figure you want to change) or by clicking Send system
date to the Detector (that way the detector is set to the same time and date as
your PC).

Here, you can select the baud rate of the Detector. Under normal
circumstances, you should select the highest possible (57,6 kbps). In case of
problems with communication (e.g. the connection breaks down at times) you
may select the lower baud rate of 38,4 kbps.

After completing all settings, click on OK to send the changes to the Detector.
Make sure that the Detector is switched on when clicking OK, because
otherwise no communication is possible.
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3.4 Setting up configuration

3.4.1 Enter system tree

Each configuration is subdivided into three levels, e.g. section — machine —
measuring point.

Setting up configuration elements

In order to create a new configuration, carry out the following steps:
e Click on System > New item (or on ;I).

e Name the entry, e.g. "Cement Plant 1”.

e Add the new sub-entry by clicking on System > New sub-item or click on .
That way, you add a new section to the configuration. Name that e.g. "Section
1"

e Exactly as with the section, add another machine (“Machine 1”) and a new
measuring point (“Measuring Point 1”) by following the sequence via New sub-
item.

Moving or copying configuration elements

You can only move configuration elements if the target is on a higher level, i.e. you
can

e move or copy a measuring point (level 3) to another machine (level 2), and
e move or copy a machine (level 2) to a different section (level 1).

If the target already contains sub-elements, the moved/copied
g' element is always appended to the end of the list.

Moving an element

o Left-click on the element, keep the mouse button pressed, and drag the element
onto the target element.

e Release the mouse button to insert the element.

Copying an element

e Left-click on the element while pressing the CTRL key, keep the mouse button
and CTRL pressed, and drag the element onto the target element.

¢ Release the mouse button and CTRL to copy the element.
or:

¢ Right-click on the element and select Copy.

¢ Right-click on the target element and select Paste.
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or:

¢ Right-click on the element, keep the mouse button pressed, and drag the
element onto the target element. A pop-up menu displays.

e Select Move.

3.4.2 Automatic assignment of RFID tags to measuring points

In order to simplify allocation of measuring points in the Trendline configuration to
measuring point in your system, you can add RFID tags to them. The Detector can
read existing RFID tags at the measuring points and automatically assign the
measured values to the correct measuring point in the Trendline software.

If you transfer a configuration with RFID settings to a Detector
g without an RFID reader, it displays an error after data transfer and
ignores the RFID settings.

Assigning an RFID tag to a measuring point

Before using, you must assign the RFID tags placed on the measuring points. You
can do this immediately before a CM or balancing measurement. Select the
measuring points wither in the Trendline software or in the on-site Detector:

Selection in the Trendline software

1. Select a measuring point in the Trendline configuration.
2. Click on the Configuration tab.

3. In the RFID Status box select Assign RFID.

4

. Repeat this procedure for all measuring points to which you wish to assign RFID
tags.
. Send| 671 the configuration to the Detector.

6. During the round, select the appropriate measuring point in the Detector (see
Selection of measuring point 183)).

a) Select Start measurement. The Detector reads the RFID tag on site and
assigns it to the measuring point.

b) If you do not want to perform a measurement but just want to assign the RFID
tag, select Assign RFID at the appropriate measuring point on the Detector.

7. Load the data from the Detector in Trendline. The RFID status of the measuring
points is now set to "RFID assigned" and the green RFID icon is displayed in
front of the measuring point in the configuration tree.

(&)
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You can set the status of all measuring points of an element (e.g. a

g/ machine) to "RFID assigned". To do so, right-click the element and
select Assign RFIDs globally. On the next round with the Detector
you can assign the RFID tags placed here to all the appropriate
measuring points.

Selection in Detector

1

. If you have not assigned an RFID tag to a measuring point yet, you can also

assign one on the Detector. You can assign it immediately before a CM/
balancing measurement or before a run up/coast down test. Select the
measuring point on the Detector and then the Assign RFID command. You can
then perform a measurement.

. Load the data from the Detector in Trendline. The RFID status of the measuring

points is now set to "RFID assigned".

Removing the assignment of an RFID tag

1.

Select a measuring point with an RFID tag assigned in the Trendline.

2. Click on the Configuration tab.

o b W

. In the RFID Status box select Delete RFID.
. Send| 67 the configuration to the Detector.
. During the round, select the appropriate measuring point in the Detector (see

Selection of measuring point/183)).

. Select Start measurement. The Detector prompts you to delete the tag.

Delete the tag and select Tag deleted.
If you do not delete the tag, select Tag stays.

. Continue measuring.
. Load the data from the Detector in Trendline. The RFID status of the measuring

point is set to "No RFID" if the tag was deleted.

You can globally delete all RFID tag assignments to measuring

g/ points of an element (e.g. a machine) in the configuration. To do so,
right-click the element and select Delete RFIDs globally. On the
next round, confirm deletion of the RFID tag assignment for each
measuring point before the measurement.

Changing the assignment of an RFID tag

To change the assignment of an RFID tag to a measuring point: First change the
RFID status in the Trendline configuration and transfer the modified configuration
to the Detector. On the next round with the Detector, you can then import the new
RFID tag.
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. Select the measuring point in the Trendline configuration.
. Click on the Configuration tab.

. In the RFID Status box select Edit RFID.

. Send| 67 the configuration to the Detector.

. During the round, select the appropriate measuring point in the Detector (see
Selection of measuring point/183)).

6. Select Start measurement. The Detector prompts you to delete the tag.

a b WON -

a) Delete the tag and select Tag deleted. You can now assign the new RFID
tag.
b) If you do not delete the tag, select Tag stays.
7. Continue measuring.

8. Load the data from the Detector in Trendline. The new RFID tag is assigned in
the measuring point in the system configuration.

Exchanging a defective RFID tag

If communication with the RFID tag at a measuring point does not work, the user
can mark it as "defective" in the Detector and then continue measuring. After the
next data synchronization with the Trendline software, the RFID status "RFID
defective" is displayed at the measuring point and recursively up to the top level in
the configuration tree. You can then assign a different RFID tag to the measuring
point.

1. The Detector cannot read the RFID tag at the measuring point. Select RFID tag
defective in the Detector.

2. The program displays "Is the tag defective?". Select Yes.
3. Delete the RFID tag from the measuring point.

4. Load the data from the Detector in Trendline. The RFID status of the measuring
points is now set to "RFID defective".

5. You can now assign a different RFID tag to the measuring point.

Additional information

e You can abort Detector RFID tag assignment handling functions by pressing
Esc. This preserves the previous state of the assignment.

¢ If the Detector recognizes an RFID tag that is not in the configuration, it displays
the error message: "At least one configuration does not exist".

3.4.3 Create a measuring point

The settings for the measuring point can now be made. Three tabs are assigned to
each measuring point in the right-hand window: Information! 467, Configuration| 467
and Measured values | 88",
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Info

Comments on this measuring point may be entered in the field provided in the

Information tab. It is also possible to insert an picture. To do this, click [ and
select the desired picture in the file dialogue. Please observe that these pictures
should not be larger then 100kB, otherwise the program will run more slowly with a

lot of large pictures. You can print out the picture using = and remove it using b
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RFID status

In this section you can display and edit the status of an RFID tag assigned to the
measuring point:

¢ No RFID No RFID tag is assigned to the measuring point.
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o Assign RFID This option instructs the Detector to assign an RFID tag placed on
the machine to this measuring point during the next round.

o RFID assigned An RFID tag is assigned to the measuring point. The unique ID
is displayed in the RFID number field.

e Delete RFID This option instructs the Detector to cancel the RFID tag
assignment to the measuring point during the next round.

¢ RFID defective The Detector has marked the assigned RFID tag as defective.

e Change RFID This option tells the Detector to replace the assigned RFID tag.
During the next round, you must delete the tag and assign a new one before you
can perform the measurement at this measuring point.

You can only select the statuses that are accessible as a follow-up
gf status of the current status.

See also
Automatic assignment of RFID tags to measuring points | 43",

Sensor

You can adjust the vibration measurement sensors and the temperature at Sensor
. Only the sensors that were previously entered in the sensor database will be
available for selection (see Add sensor/347). You can select a sensor for
Acceleration, Temperature and Trigger from the sensor database.

Time signal

In this area you can specify how the Detector should handle time signals (211, FFTs
and characteristic values.

e Charac. value averaging: the FFTs or characteristic values calculated from the
time signals are averaged. If the average of four values is determined, for
example, four values are recorded in succession, the FFT is calculated and the
(frequency selective) characteristic values are produced. The time signals
stored for the purposes of an averaged measurement are always the last time
signals measured. Select FFT to determine the mean values of the FFTs
calculated from the time signals and select Char. values to apply the average
determined for the characteristic values calculated from the FFTs.

e You can set the resolution of the spectrum under FFT lines. Select 1600
(corresponds to 4096 samples) or 3200 FFT lines (corresponds to 8192
samples).

e You can use Save time signal to specify when a time signal should be saved:
never, always or on alarm (a main alarm).
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e At Lowpass you can select a low pass frequency for the frequency band to be
measured from a predefined list. The sample rate in this case is always 2.56
times the selected low pass frequency.

Note that the filter calculation in the software is performed at the
g/ 200 Hz and 500 Hz settings and is therefore slower than at the
other frequencies. Therefore, you should only select this high
frequency if you really need it. Otherwise, select a greater number
of FFT lines: For example, it is faster to measure at 1 kHz / 3200
FFT lines than at 500 Hz / 1600 FFT lines, although both
measurements are performed at the same resolution.

Apart from Save time signal the time signal settings can no longer
g' be changed after the first measurement as otherwise it would no
longer be possible to compare characteristic values.

Rotational speed

If the rotational speed also needs to be determined by the Detector during the
measurement select the Acquire turning speed option. The nominal rotational
speed as well as the maximum permissible deviation in RPM should also be
entered in the appropriate input fields. If the rotational speed deviates from the
rotational speed band defined here during measurement, the Detector issues an
error message but still performs the measurement.

Bearing list template

In this section you can assign bearings from the bearing databasel68) to the
measuring point or delete an assignment. The associated kinematic frequencies of
the selected bearing are then also displayed in the evaluation diagram in the FIS-
Viewer. Both when making assignments and deleting assignments you can choose
whether

¢ to only apply bearing data in future
¢ for all measurements already performed, or
¢ only for measurements from a certain period

Specify the bearing assignment at measuring point level in the
g' configuration. You can also assign bearing data directly to individual

measured values. For more information refer to Measured values
88%_
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Add bearing
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e Selecting measurements:

o If you only want to apply the bearing information for future measurements,
click Do not add this bearing to any measurement of this measuring
point.

o If you want to apply the bearing information to all saved measurements, click
Add this bearing to all existing measurements of this measuring point.

o To apply the bearing information to measurements in a certain time range,
click Add this bearing to all measurements of following timerange and
select the time range.

¢ In the Bearing configuration section enter the speed transmission ratio and
select whether the bearing has a fixed outer race.

Disable bearing

| .
e Click on the bearing to delete and then .
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e Selecting measurements:

o To keep the bearing information for the existing measurements of this
measuring point, click Do not disable the bearing for any measurement of
this measuring point.

o To delete the bearing information from all saved measurements of this
measuring point, click Disable the bearing for all existing measurements
of this measuring point.

o To delete the bearing information from measurements in a certain time range,
click Deactivate bearing for all measurements of following timerange and
select the time range.

Displaying bearing information

e Click on the desired bearing and then 2. This displays the bearing information

in the bearing database.

Measured values

In the Measured data section you can display the acquired data numerically and
graphically. For more information refer to Measured values | 88",

3.4.4 Setting characteristic values

You can create the following characteristic values per measuring point:

e |ISO 10816
° Asel and Aeff’
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Dsel and Deff’

Temperature,
oV
sel’

e Crest factor.
Please also observe the information in the "Frequency selective characteristic

values /212" section.

Characteristic values can be changed until they have been sent to

g' the Detector for the first time. After that the characteristic values
turn grey in the tree and cannot be altered anymore. Otherwise, the
measuring results could not be compared.

To add a new characteristic value, right-click the measuring point the characteristic
value is meant for and, after that, on New sub-item. Alternatively, you can do it via

System > New sub-item or via EIE Now, the following window opens.

Maw chmrmctansBic wiklus

Typn

[® 501006 -

H-:b| ok | e |

Under Type various characteristic values can be selected, which can be measured
with the detector. With selective characteristic values (e.g. ag) the upper and

lower cut-off frequency can be set in Frequency min. and Frequency max.,
between which the characteristic value will be calculated. More information to that
you will find in Frequency selective characteristic values/212\. For the other
characteristic values (ISO 10816, a ¢ and d ) the cut-off frequencies are pre-set.

In the Alarm section you can set a threshold value for each characteristic value. If
this is exceeded by a measurement, both Detector and Trendline software show
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an Alarm. Additionally, a preliminary alarm threshold can be set in Trendline
software. If the measured value exceeds this threshold, preliminary alarm is given
for this measuring point in Trendline software. The Detector shows main alarms
only. Prealarms are only displayed in Trendline.

See also
Reset alarm status| 2.

3.4.5 Editing / deleting sensors

If you have added custom sensors /347 in addition to the pre-defined sensors, you
can edit or delete them. However, this is only possible if the sensor is not being
used in a configuration!

Editing a sensor
e |n the Detector menu click Sensor > Edit.
e Select the sensor in the Edit sensor window.

o Edit the settings (see also Add sensor/ 34") and click OK.
If the sensor is in use, the input boxes are grayed out and you cannot edit them.

Deleting a sensor
¢ In the Detector menu click Sensor > Delete.

e Select the sensor to delete in the Delete sensor window and click OK.
If the sensor is in use, this is displayed in the window and you cannot delete it.

3.4.6 Managing measurement comments

In the Trendline software you can create short texts as measurement comments.
The comments list is synchronized whenever data are exchanged with the
Detector. During the measuring round, you can assign a comment from the list to
every measurement on the Detector. The comment is saved with the measurement
and displayed in the measuring results in the Trendline software. You can then edit
the comment if necessary (see "Measured data/ 8").
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Create comment

Click Comment selection list in the Detector.

In the Comments window click +
Enter the desired text and click .
Click Close.

Delete comment

¢ Click Comment selection list in the Detector.
¢ In the Comments window click #*.

e Click Close.

Edit comment
e Click Comment selection list in the Detector.
e |In the Comments window click f.

e Enter the new text and click .
e Click Close.

3.4.7 Add balancing configuration

To create a balancing configuration click on a level 3 configuration element
(machine or motor, for example). Then click System > Add balancing
configuration.
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RFID status

In this section you can display and edit the status of an RFID tag assigned to the

measuring point:

¢ No RFID No RFID tag is assigned to the measuring point.

e Assign RFID This option instructs the Detector to assign an RFID tag placed on
the machine to this measuring point during the next round.

e RFID assigned An RFID tag is assigned to the measuring point. The unique ID

is displayed in the RFID number field.

e Delete RFID This option instructs the Detector to cancel the RFID tag
assignment to the measuring point during the next round.

¢ RFID defective The Detector has marked the assigned RFID tag as defective.

e Change RFID This option tells the Detector to replace the assigned RFID tag.
During the next round, you must delete the tag and assign a new one before you

can perform the measurement at this measuring point.
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You can only select the statuses that are accessible as a follow-up
g status of the current status.

See also
Automatic assignment of RFID tags to measuring points | 43",

Balancing settings

Type of vibration unit: Select Acceleration, Velocity or Displacement.

Characteristic: Specify here whether the peak-to-peak value, the peak value
or the root mean square (RMS) should be evaluated.

Balancing OK at: define the limit value for the balancing measurement here. If
all measured values are below the value specified during the trim run(198 the
balancing procedure has been successfully completed and the Detector ends
the balancing measurement.

Rotational speed settings

Enter the Nominal turning speed (in the predefined unit, see "Program settings
/ General/110"") and the Max. permissible deviation in the appropriate input
boxes. Note that a deviation of more than 10% is not possible. If the rotational
speed measured by the Detector is outside the rotational speed band defined
here the Detector outputs an error message 205,

During the measuring process the Detector averages the rotational speed
values. Specify how many rotational speed values are to be used for averaging
at Number of averages to be determined during one measurement. If you
enter 20, for example, the Detector averages the values obtained for rotational
speed across 20 revolutions.

Balancing plane settings

Number of balancing planes: Select "1" for single-plane balancing or "2" for
two-plane balancing.

Enter a plane name for the selected planes or use the name suggested
Trendline software (see also "Program settings / General[110""). Due to the
Detector display this name can only contain 5 characters.

Click Continuous if you can attach the balancinf weights anywhere on the shaft.
If this is not possible (e.g. with a fan with 10 blades), Continuous must not be
selected.

If you deactivated Continuous, use Discrete positions to select the number
of possible positions for the balancing weights, e.g. for a fan. In addition, please
enter the angle of the next possible position against the direction of rotation to
the reflex mark edge in Angle trigger mark -> Pos. 1. This position is called P1.
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Resonant frequency bands
In this section you can manually enter the resonant frequency bands determined
for this measuring point.
HIE
1. Click on .
2. Enter the name of the frequency band.
3. Select Lower frequency and Upper frequency and click OK.

You can copy resonant frequency bands determined from a run up/
g/ coast down test and subsequent creation of an amplitude/phase

diagram to the balancing configuration (see Setup run up/coast
down| 61).

Sensor configuration
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Sensor position settings

In this section you can insert up to four sensor positions. Each balancing plane
must have at least one sensor position. If you add a new balancing configuration to
the system configuration, a sensor position is automatically added per balancing
plane.

Sensor position: Enter a name for the sensor here (maximum of 5 characters).
Due to the size of the Detector display this can only be 5 characters long.

BNC connector: Select the BNC port/1761 used to connect the sensor during the
measurement. If you are measuring with two sensors, you should use both BNC
connectors on the Detector as this accelerates the speed of measurement.

Angle: Enter the angle of displacement of the sensor from the zero position in
the direction of shaft rotation. The stator is always used as the reference for the
zero position which points vertically upwards.

Sensor: Select the sensor used from the sensor database! 341 here.

Trigger settings

Select trigger sensor: Select the trigger sensor used from the sensor database

| 34% here.

Name of trigger position: Enter a designation for the trigger position. This is
required for identification of the trigger sensor by the Detector. Due to the size of
the Detector display this name can only be 5 characters long.

Angle of trigger sensor: Enter the angle of displacement of the trigger sensor
from the zero position in the direction of rotation.. The stator is always used as
the reference for the zero position which points vertically upwards.

Select Positive or Negative to indicate whether the measurement should start
on a positive or negative edge on the trigger sensor. This edge determines the
0° position of the shaft.

Configured angles

In this area the Trendline software provides a graphic representation of the
position of the sensors.

The sensor positions are always counted in the direction of shaft

g rotation.

Measured data

You can view the measured data in this area once a balancing measurement is
complete and the data have been transferred to the Trendline software from the
Detector.
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Edit comment

¢ |n order to edit a measurement comment, click on the measurement and then
Edit comment of selected balancing step.

Show details
To display the details of a measurement click on the appropriate entry in the list
then click on — .

The Trendline software displays the sensor position, time of measurement,
rotational speed, amplitude and phase of the vibration at the sensor at each stage
of the balancing measurement. If you also wish to see the coefficients used and
their corresponding amplitude and phase click Show coefficients.

If you wish to hide the details again click on

Display sensor charts

Click Sensor charts to display the position of the sensors as a chart. Trendline
enters the sensor position on a circular chart for each individual step of the
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measurement. You can activate/deactivate the display of each sensor at Sensor
position <n>.
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Display weight graphics
Click Weight charts to display the weights as a chart. The Trendline software

enters the position of the weights during the trial run and trim run in a circular
chart. You can switch the display of weights for each plane on or off by clicking on

Applied weights - Plane <n>.
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The positions of the weights are indicated against the direction of
5/ shaft rotation.
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Print view of graphics
ord
Click on &3 to call up a print preview of the graphics.

Balancing report

=3
Click on & to generate a balancing report/102),

Delete balancing data

To delete the data obtained during a balancing measurement click the
corresponding entry in the list then click . Click on .
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3.4.8 Setting up run up/coast down
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RFID status

In this section you can display and edit the status of an RFID tag assigned to the
measuring point:

No RFID No RFID tag is assigned to the measuring point.

Assign RFID This option instructs the Detector to assign an RFID tag placed on

the machine to this measuring point during the next round.

RFID assigned An RFID tag is assigned to the measuring point. The unique ID
is displayed in the RFID number field.

Delete RFID This option instructs the Detector to cancel the RFID tag
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assignment to the measuring point during the next round.
RFID defective The Detector has marked the assigned RFID tag as defective.

Change RFID This option tells the Detector to replace the assigned RFID tag.
During the next round, you must delete the tag and assign a new one before you
can perform the measurement at this measuring point.

You can only select the statuses that are accessible as a follow-up
g/ status of the current status.

See also

Automatic assignment of RFID tags to measuring points | 43",
Acceleration sensor settings

Vibration sensor: Select the sensor used from the sensor database! 34" here.

Name of sensor position: Enter a designation for the sensor position. This is
required for identification of the sensor by the Detector. Due to the size of the
Detector display this name can only be 5 characters long.

Angle of vibration sensor: Enter the angle of displacement of the trigger
sensor from the zero position in the direction of rotation.. The stator is always
used as the reference for the zero position which points vertically upwards.

Trigger settings

Select trigger sensor: Select the trigger sensor used from the sensor database
|34 here.

Name of trigger position: Enter a designation for the trigger position. This is
required for identification of the trigger sensor by the Detector. Due to the size of
the Detector display this name can only be 5 characters long.

Angle of trigger sensor: Enter the angle of displacement of the trigger sensor
from the zero position in the direction of rotation.. The stator is always used as
the reference for the zero position which points vertically upwards.

Select Positive or Negative to indicate whether the measurement should start
on a positive or negative edge on the trigger sensor. This edge determines the
0° position of the shaft.

Run up / coast down settings

In this section you can make settings required for Determining the resonance
range of a machine 1991 with the run up/coast down test.

Type of vibration unit: Enter which vibration unit to use at run up/coast down.
The following are available: Displacement, Velocity and Acceleration.

Characteristic: Specify here whether the peak-to-peak value, the peak value
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or the root mean square (RMS) should be evaluated.

e Measurement type: Enter whether the Detector measures during run up or
coast down of the machine

Frequency settings

In this section you can set the start and end frequency for Determining the
resonance range of a machine 1991 with the run up/coast down test.

e Use automatic start frequency: Enter the frequency at which the Detector
starts measuring.

¢ Use automatic end frequency: Enter the frequency at which the Detector stops
measuring.

Expert settings

The settings in this section concern conditioning of the measuring signal
determined while Determining the resonance range of a machine 1991 with the run
up/coast down test.

e Order: Select what signal order the Detector should determine (1 = rotational
speed signal, 2 = 1st harmonic, 3 = 2nd harmonic, 4 = 3rd harmonic).

e Signal length: Enter how many samples (1024, 2048 or 4096) the Detector
should measure per measuring signal.

e Use Hanning windowing: Select whether the Detector should use Hanning
windowing when conditioning the measuring signal. Hanning windowing leads to
better quality of the digitized measuring signal, particularly at low rotational
speeds. However, this additional step requires computing time in the Detector
and leads to increased noise in the digitized signal.

The effects of this setting depend very much on the type of machine
g and on the individual demands on the ratio of accuracy to the
number of signal support points. As a general rule, you should

e measure as many amplitude and phase values as possible for
machines that run up/coast down quickly - i.e. reduce signal
length and thus signal quality and do without Hanning windowing,

e increase accuracy for machines that run up/coast down slowly, i.
e. increase signal length and thus signal quality and activate
Hanning windowing.

Measured data
In the Measured data window you can
e create an amplitude/phase diagram for a set of measured data,

e save frequency bands selected in the diagram and copy them to a balancing
configuration| 53",
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The Run up/coast down measurements section displays the run up/coast down
measurements saved for the measuring point.

Limit time range

e In order to limit the time range of the measured values displayed, select the
Time range option.

e Set the desired start and end date.

Edit comment

e In order to edit a measurement comment, click on the measurement and then
Edit comment.

Below the measurements the window is split into three sections. The amplitude/
phase diagram is displayed in the middle, with the diagram editing tools to the left.
To the right of the diagram there is a list of the user-defined frequency bands.

Displaying the amplitude/phase diagram and setting the frequency band

Click on a measurement to display the amplitude/phase diagram in the diagram
window. You can use the FIS-Viewer zoom tools described in the "FIS-Viewer 14T
section to edit the diagram. Cursor tools for the diagram include the base cursor

64



Trendline 3

(see "Cursor tools|137") and a difference cursor, with which you can specify a
frequency band.

How to specify a frequency band in the amplitude/phase diagram:

e Move the base cursor (yellow) to the measuring point to specify the lower cutoff
frequency.

¢ Move the difference cursor (green) to the desired measuring point to specify the
upper cutoff frequency.

In the diagram information, you can read the position of the base and difference
cursor and the width of the frequency band and amplitude difference.

Saving the frequency band

1. Select the frequency band in the amplitude/phase diagram and click .
2. Enter a name for the frequency band and click OK.
or:

B
1. Click on .+.
2. Enter the name of the frequency band.
3. Select the start and end frequency and click OK.

Deleting a frequency band
1. Click on the frequency band to delete.

2. Click on .X

Copying frequency bands to a balancing configuration

1. Click on %

2. The Add frequencies to balancing configuration window displays the
balancing configurations available in the system configuration. Select the
desired balancing configuration and click OK.

3.4.9 Change alarm levels automatically

The Trendline software can automatically adjust the alarm settings for the
individual characteristic values. During this process the software determines the
average of all measured values for the relevant characteristic value and
automatically adjusts the corresponding alarm value according to your
specifications. Alternatively, you can use the values suggested by the software.

CAUTION Modification of alarm thresholds may have severe effects on the
service life of the monitored components if used improperly. You
should therefore always carefully check whether the intended
settings are suitable for your specific system.
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To modify the alarm values automatically proceed as follows:

o Select the required element from the configuration tree — a specific machine, for
example. The alarm values for this element and all sub-elements it contains are
modified.

e Click on Alarm thresholds in the System menu.
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Specify time range

You can use the Time range option to limit the measuring values used for
averaging. To do this, enter the start and end time. Alternatively, you can enter the
end time and specify the duration in whole days in the No. of days input field. In
the latter case the start time is automatically determined.

Configuration of automatic adjustment

Automatic adjustment of alarm values can be defined for each individual
characteristic valuel 157 (acceleration, demodulation, velocity and temperature) of
the element selected in the configuration tree.
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To activate the automatic adjustment for one characteristic value proceed as
follows:

e Select the characteristic value.

e Enter the main alarm adjustment as a factor of the average value.
e Enter the pre-alarm adjustment as a percentage (less than 100).
or:

¢ Click Recommended to set the values recommended by Trendline.

The values suggested by Trendline for the automatic adjustment of
Ly’ alarm values are based on empirical values used by FAG Industrial
5 Services GmbH. As entirely different settings may be required
depending on the properties of the components being monitored
these must be regarded purely as suggested values which are
therefore non-binding. In all cases the user is responsible for
selecting appropriate alarm values.

Select the machine class for the characteristic value ISO 10816.

|: Parts of enaines and machines with poveer up ta 15kW

[I: 15kM up ko 75k without bazeplate aor up bo 300kMW with special bazeplate
[ll: Large machines suited on heavy baseplates

I': Large machines with power higher than 10M%W on swinging bazeplates

3.4.10 Send configuration

You can send a configuration or a part of a configuration to the Detector. For that,
follow the sequence below:

e Select a machine in the tree.
e Connect the connector to the serial interface using the data cable.

e Switch on the detector.
-

e Click on Detector > Send configuration in Trendline 3 software or click on

Now, the configuration for the machine selected including all measuring points is
sent to the Detector. If you want to send a complete configuration, you would have
to select the configuration in the tree (in the example in paragraph 3.3.1 this would
be “Cement Plant 1”) prior to sending the data. It is even possible to send one
measuring point. This facility is mostly used for test purposes.

67



WIS

If the "Always save" option is selected for more time signals in the

g/ configuration that you wish to send to the Detector than are
permitted in the Detector memory an error message will be output
and the data will not be transferred. Also refer to Frequency
analysis|217\

3.4.11 Deleting the Trendline database
To delete a Trendline database and remove all configuration and measured data
irreversibly, the database must be open.

e To delete the currently open Trendline database, click Delete current database
in the Tools menu. The program displays a security prompt.

¢ Click Delete to delete the database irreversibly.

»

You cannot interrupt the delete process!

3.5 Bearing database

The Trendline database provides you with data on the most widely used bearings
for use in your individual configuration (see Setting up measuring point/ 457).

You can also add your own bearings |71 to the above. Furthermore, the Trendline
bearing database also includes a group administration feature! 75 which you can
use, for example, to group bearings of different makes that have similar
characteristics.

Click Tools > Bearing database to open the bearing database.
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3.5.1 Search bearing

To find a bearing click on Search bearing in the bearing database.

e Click on H to display all bearings.
e To restrict the search you can specify the manufacturer and/or group.

e Additionally, you can further limit the name of the bearing in Search criterion.
You can use the wildcards "?" and "*" in the usual way, e.g.

o "*1200*" to find all bearing names containing 1200 or
o "?200*" to find all bearings whose name includes the text "200" at position 2-4.

The list of hits is displayed in Search resuilt.
e Select the bearing to be modified and click on Continue.
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e Enter the data for the required bearing as described under Add bearing! 71".
e Click on Save.

If the search results do not return a bearing, the bearing database may be
defective or inaccessible. Then proceed as follows:

e Close the Trendline software.

o Deregister the database by running the deinstall fis bearing db ocx.
bat file in C:\Program Files\Common Files\FIS\BearingDB.

¢ Register the database element by running the install_fis_bearing_db_ocx.bat
file in the same directory.

e You can now restart Trendline.
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3.5.2 Add bearing

To add a bearing to the bearing database click on Add bearing.
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e Select a manufacturer from the list.
e Enter a name for the bearing in the Label field.
e Detailed comments may be entered in the Comment field (optional).

Geometry data or damage frequencies

e Use the Geometry and Frequencies options to switch between the input fields
in the right-hand area of the window in order to enter corresponding data. When
inputting the contact angle select either degrees or radians as the unit. When
specifying the frequencies enter whether these should be in Hz or rpm.
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Trendline indicates whether any information still needs to be input in

g/ the bottom right-hand area of the window. The bearing can be
added to the database only if all input is complete.

¢ Click on Continue to store the bearing in the bearing database.

3.5.3 Edit / delete bearings

Editing bearings

Click on Edit bearing and start by searching for the corresponding bearing as
described at Search bearing| 69,
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The list of bearings found is displayed in Search result as well as the number of
hits.

e Select the bearing to be modified and click on Continue.
e Enter the data for the required bearing as described under Add bearing! 71".
e Click on Continue.

Click on ‘Lito open the Manufacturer details window. You can call
g/ up the contact details for the manufacturer here.

Deleting a bearing
e Carry out your search initially as described above| 72" then select the bearing to
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be deleted from the Search resuilt.
e Click on Delete bearing to remove the bearing from the database.

| You can only delete bearings that you have entered! 71" yourself!
g/ Once all the bearings for a particular manufacturer have been
deleted you can also delete the manufacturer! 78",

3.5.4 Exporting / importing bearings

Exporting bearings

Click on Export bearing and carry out your search for the bearing to be edited as
described under Edit/delete bearings! 72\
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e You can use the Export self-created bearings only option to restrict the
export to bearings you yourself have entered.
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e Click Q and select the path and file name. By default, Trendline uses a file
name according to the convention
FISBearingDB export <year> <month> <day>.zip. Alternatively, you
can use your own file name.

Importing bearings

e Click on Import bearings, then on B
e Select the import file.

3.5.5 Manage groups

You can use the manage group feature to classify bearings with similar
characteristics regardless of their manufacturer.

e Click on Manage groups to call up the bearing database group administration
feature.
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Create a new group

e To create a new group click on E
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Enter a name for the new group and click on OK.

Assign bearings to a group

To assign one or more bearings to a group proceed as follows:

Select the desired group from the Group list.

Search for one or more bearings as described at "Edit/change bearing ->
Search bearing! 72". The bearings found are displayed in the Unassigned
bearings list.

To assign a bearing to the group click on it then click on *. The bearing should
now be displayed in the Assigned bearings list.

To assign all bearings found to the group click on “#. All bearings should now
be displayed in the Assigned bearings list.

To delete a bearing from the group click on the bearing in the Assigned
bearings list then click on * .

To delete all bearings from the group click on **.
Click on Save assign the bearings to the group in the bearing database.

Rename a group

To rename a group select it from the Group list and click on ?

kename growe x|
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Enter a new name for the group and click on OK.

Delete a group

To delete a group select it from the Group list and click on .

Please note: the group is deleted immediately - you will not be
g' prompted to confirm this! You should therefore only use these
functions if you are sure that you wish to delete a group.
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3.5.6 Add manufacturer

vigh fmrpsm

e Click on Add manufacturer to create a new manufacturer.

Craale new manulaclurars

e Enter the manufacturer's data in the appropriate input fields and click on Next.

e Check your input in the window that subsequently appears. If the input is correct
click Add to save the manufacturer in the bearing database or click Back to
modify your input as required.

3.5.7 Edit / delete manufacturer

Edit manufacturer
¢ Click on Edit manufacturer to modify the data for one manufacturer.
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e Change the manufacturer data and click on Next.

¢ In the next window the Trendline shows your changes and the original data for
an easy compare. Click on Save to stored your changes in the bearing database
or click on Back to change your data.

Delete manufacturer

When you have deleted all bearings from a manufacturer from the database (see
Edit/delete bearings| 72%), you can also remove the manufacturer.

e Click Delete manufacturer.
e Then select the manufacture from the Manufacturer list and click Continue.
The manufacturer is then deleted from the bearing database.

You can only delete manufacturers which have been added| 78" by

g/ yourself!
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3.5.8 Select a different bearing database

e Click on Change bearing DB.

Change dotabase x

—Connection source
™ Usze datafile
I j Search..
& sze connection shing
I Connect
k. Cancel Help

e Select Use connection string and click Connect.

B8\ Data Link Properties |

Praowider | Ennnectinnl .ﬁ.dvancedl Al I

Select the data you want to connect to;

OLE DB Provider(z] -
tMediaCatalogDB OLE DB Provider

tediaCataloghdergedDB OLE DB Prowvider
tediaCatalogiw/ebDE OLE DE Provider

Microzoft Jet 3.51 OLE DB Prowider

Microzoft Jet 4.0 OLE DB Provider

Microgaft OLE DB Prowvider Far Data Mining Services
Microgzoft OLE DB Provider for DTS Packages

Microgoft OLE DB Provider for Indesing Service

Microgaft OLE DB Provider for Internet Publishing

Microzoft OLE DB Provider for ODEC Drivers

Microgaft OLE DB Prowider for OLAP Services 3.0

Microzoft OLE DB Provider for Oracle

Microzoft OLE DB Provider for Outlook, Search

Microzoft OLE DB Provider for SLIL Server

Microzaft OLE DB Simple Provider b
M50 ataShape
OLE DB Provider for Microzoft Directony Services ll

Cancel | Help

e Click on Microsoft OLE DB Provider for SQL Server then click Next.
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EE) Data Link Propetties x|

Provider Connection |.-'1'-.|:|van|:eu:|| All I

Specify the following to connect to SOL Server data:
1. Select or enter a server name:

POR0S5E19YFIS_DATABASE j Eefreshl

2. Enter infarmation ko log on to the server:;
i~ Usze 'Windows MT Integrated zecurity

% Use a specific uzer name and pazsword;

Uzer name: Isa

Fazzword: Iu“
[T Elank password W Allow saving password
3, (% Select the database on the server;
IBearingDB j
(" Aftach a database file az a database name;

I zina the filemame;:

| |

T ezt Connection |

k. I Cancel | Help |

e Select the database server that contains the bearing database from the server
list or enter the server in the input field in the upper area of the window. Click on
Refresh to update the list of available servers.

If you do not find any entries in the server list due to restricted user
S/ permissions, enter "Computer name\FIS_DATABASE" manually (if
the name of your computer, for example, is "peters laptop”, the
server name would be "peters_laptop\FIS DATABASE"). You can
find your computer's name in the Windows Explorer drives. If you
are not sure about your computer's name, ask your administrator.

e Select Use a specific user name and password and enter your user name
and password to log-on to the bearing database. If you select a database server
that was installed during a Trendline installation (contains FIS_DATABASE in its
name), the user name is sa and the password is sql8. Enable Allow Password
Save to save the password.

e Select a Bearing DB from the list.
¢ Click on OK then also click OK in the Change database window.
The modified bearing database is now available for use.
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For the database server installed with Trendline the user name is
g' "sa" and the password is "sql8".

3.6 Create a route

After the system structure has been entered into a configuration (or several
configurations just as well), there is the option to group parts of those
configurations into routs using the function route. For example, one could create a
route for each day of the week and measure certain machines only on Monday. A
route for a certain mechanic, who maintains some machines of a configuration
only, would be feasible just as well.

Should you want to take measurements at a measuring point not contained in the
current route, you can take a free measurement with the Detector for that. To
define the settings for that, at least one template must have been created| 834
before. In this template you can set exactly the same properties as in an ordinary
measuring point like characteristic values, sensor type, time signals, etc.

3.6.1 Create a new route

Open the window for the route planning under Planning > Route. A new window
will open up, which is subdivided into three parts. On the left, you will find the
configuration tree, in the middle the routes and on the right-hand side, same as in
the configuration display, the settings. To create a new route, follow the sequence
below:

1. Right-click the middle window and subsequently on Add Route. Alternatively you
can click on __1 just as well.

2. Nams the route in the right window and add a picture, if desired (for that, click
on [&).

3. Now, you can add elements from the configuration to the route. You can do that
in two different ways:

a) Left-click the element you want to add to the route in the configuration tree.
Subsequently, left-click the route you want to change in the middle window.
Finally, right-click the middle window and then left-click Add Selection.

b) Left-click on the part of the configuration tree you wish to add. Keep the left
mouse button pressed and drag the element onto the name of the route.
Release the mouse button.

4. Repeat this procedure for all routes you want to create, e.g. for Monday to
Friday.

Use the button = to print a route report to get an overview over the created
routes. The following window is opened:
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R oute

I Route j
Help |

In this window you must select the route you want to print in the route report.

In this window you can select the route you want to display in the report.

3.6.2 Create template

A template is a pattern for free measurements, i.e. measurements which are not
in the current route.

You can send up to five templates for free CM measurements,
gf balancing templates, and run up / coast down tests in a route.

A template has the same layout as a measuring point. As with a measuring point,
time signals can be recorded and different characteristic values set. If you want to
associate a free measurement with a certain measuring point, the template for this
measurement must have the same layout as the respective measuring point. That
means, the same characteristic values (with the same cut-off frequencies) must be
set and the sensor must correspond as well. Time signals and alarm thresholds
may differ, as the characteristic values can be compared none-the-less.

e To create a new template, click in the Planning-menu on Template.
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e Click on_lto add a new template group.
e Under Name you can name the group, under Picture you can include a picture
with L&,
— with you create a new template. Here just as well, you can change the
name (under Info) and insert a picture. Once you have created five templates

into a group, you cannot add any more into this group. On the page
Configuration you can set the sensor type and the time signals desired.

— with 1 you add new characteristic values to the template. More information
to that you will find in "Set up characteristic values/ 50"

¢ In order to add a new balancing configuration to the template group click on 'EE:'
For more information refer to Add balancing configuration! 537..

e In order to add a new run up / coast down configuration to the template group
-]
click on == For further details see "Setting up run up/coast down| 61",

o With #% you can delete the element selected from the list.

E;'-
e With = and with * ¥ you can unfold the tree starting from the element
selected or close again respectively.

3.6.3 Send route

There are two ways to send a route to the detector:
_+
¢ Click on Detector > Send Route (or on ) in the configuration window.
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¢ Select the route you want to send to the Detector.

¢ If you check the checkbox Send Template, you can select one of the previously
defined template groups.

e Connect the Detector with the data cable to your PC and switch it on.

e Click OK to send the route to the Detector.

Another way of sending a route to the Detector is directly from route planning (
_-lr

Planning > Route). Click on . The Send route window opens. Then proceed

exactly as described above.

If the "Always save" option is marked for a greater number of

g' measurement points in the route you wish to send to the Detector
than are permitted in the Detector memory an error message will be
output and the data will not be transferred. Also refer to System
messages and their meaning 205,

3.7 Download data from Detector

After measuring with the Detector you have to transfer the data to Trendline 3
software. Connect the Detector with the data cable to your PC and switch it on.

-
Click on Detector > Load data from Detector or on . Now, all data, that is
configurations, time signals and free measurements, are downloaded onto the PC.
This process can take several minutes depending on the amount of data.

Once all data have been received, they are stored at the respective locations in
the database. It can happen that the program does not automatically sort the
measuring points, e.g. you have taken free measurements or the configuration on
the Detector had been created on a different PC. In this case, the sorting wizard
'8 will be started automatically for sorting the measurements into your
configuration tree.
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3.7.1 Sorting Wizard

vigh fmrpsm

When you start the sorting wizard, Trendline displays an information window
showing you why the data cannot be sorted in.

e Click Next to continue sorting in the data.
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The next window is subdivided into two parts. On the left-hand side you will find the
measuring points not yet sorted, on the right-hand side your configuration
structure. Now, there are two possibilities.

e When a measuring point, which isn't sorted in yet, exists in one of the
configurations already, you drag it with the left mouse button from the left
window on the measuring point in the configuration. If the two really do match,
the mouse cursor changes. You can release the mouse button to insert the
measurement. In the status bar you can read why it was not possible to insert at
a certain point.
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¢ Alternatively, you can use the suggestions of the Trendline software. For this,
click on Wizard and select a measuring point from the list of proposals.

Select measuring point

Pozzible measuning points:

Configuration

Section

Machine Meas. position

RFID correspo

Demo Plant 16

T 9 - 2000rprm

T 9 - 2000rprm

spindle & bottom | MP < 1S00RPM

spindle & battom | MP = 1500 RPM

If the measuring point does not exist in the configuration yet, you again have two

possibilities.

¢ If you want to add a measuring point to a machine, drag it into the right-hand
window onto the machine name it is supposed to be added to.

e Additionally, you can add new configurations, sections and machines with the
and I buttons as you did, when creating the configuration. For this, see
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also "Enter system structure | 42",

3.8 Viewing measuring data
3.8.1 Measured values

In the register Measured values the selected measured values are displayed in a
table. When a row is printed in bold, then at least one time signal for this
measurement is stored. The time, the measured values determined and any pre-
alarms or alarms that may have been output are displayed for each measurement

in the measured values view.
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Limit time range

¢ In order to limit the time range of the measured values displayed, select the

Time range option.
e Set the desired start and end date.

Changing acquired speed and comment

You can also correct rotational speeds in the Measured value view and edit the

measured values comment: Proceed as follows:
e Click on an entry in the list of measured values.
e Click Change speed and comment.
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e Enter the new values and click OK.

Displaying measured values in the Viewer

You can display one or multiple measured values in the FIS-Viewer 114,
e Double-click on a measurement to view it in the Viewer.

Trendline 3

e To view multiple measured values, click the desired measured values while

holding the CTRL key.

e Then double-click one of the selected measurements while holding the SHIFT

key.

Show/hide bearing data

Click the Display bearing data for selected measurement button to display a list
of bearings assigned to this measuring point in the configuration!45". You can also
assign bearings to measurements or delete assignments here. The activation
status of a bearing is indicated by the disabled checkbox. Both when making

assignments and disabling you can choose whether

e bearing data should apply or not for all measurements already performed, or

¢ only for measurements from a certain period

Add bearing

)
e Click and select the bearing from the bearing database.
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e Selecting measurements:

o If you want to apply the bearing information to all saved measurements, click
Add this bearing to all existing measurements of this measuring point.

o To apply the bearing information to measurements in a certain time range,
click Add this bearing to all measurements of following timerange and
select the time range.

¢ In the Bearing configuration section enter the speed transmission ratio and
select whether the bearing has a fixed outer race.

Disable bearing

| .
¢ Click on the bearing to delete and then .

' x|
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e Selecting measurements:

o To delete the bearing information from all saved measurements of this
measuring point, click Disable the bearing for all existing measurements
of this measuring point.

o To delete the bearing information from measurements in a certain time range,
click Deactivate bearing for all measurements of following time range
and select the time range.

Displaying bearing information

e Click on the desired bearing and then = :£. This displays the bearing information

in the bearing database.
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See also

Evaluating measured data with the FIS-Viewer 114

3.8.2 Graphic

On the Diagram tab, Trendline depicts the measured readings in a trend diagram
with the aid of the integrated FIS-Viewer[114. The viewer provides a visual
representation of the signals and characteristic values delivered by the Detector:

e Time signals
e Fast Fourier Transformations (FFTs)
e Trend data
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Time range

Click on Time range to limit the shown data to a defined period and enter Start
date and End date.

Alternatively you can select an End date and enter the Number of days. In this
case, the Trendline sets the Start date automatically.
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Fullscreen
Click on Fullscreen to view this graphic in the size of your monitor

Show additional bearing

Click Show additional bearing to select a bearing from the bearing database/ 68"
and display its frequencies in a trend diagram.

Toolbar

Click Toolbar to show/hide Viewer toolbar. For further information, please refer to
the description of the FIS-Viewer in the "Toolbar /115" section.

Time signal, FFT signal

When in a trend diagram a certain value is surrounded by a small circle, then there
is at least one time signal for this measurement. You can view this time signal by
marking the value with the cursor and then clicking on Time signal/FFT. When
there is no time signal for the selected value, then this symbol is grey and cannot
be selected.

Print time signal, print FFT signal

Click these buttons to include the respective signal in the trend report (cf.
"Printing").

Print

Click Print to create a trend report. The trend report combines the diagrams of the
selected measured data for printing. Each diagram is printed on a separate page.

»

3.9 Reset Alarm Status

In the system structure for each element the Trendline software displays whether
an alarm or pre-alarm was measured (also see Main window!307). It may be
sensible to reset this alarm status if the cause of an alarm has been identified and
eliminated. The alarm status must be reset manually by the user as this decision
cannot be made by the Trendline software.

More detailed information on the viewer can be found herel114),

e To reset the alarm status for a configurations element (e.g. machine or motor)
and the associated sub-elements, click on the element in the system tree.

e Then click System > Alarm Status Reset.
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Trendline 3

Only the status display in the system structure is affected when the
alarm status is reset. The measuring datalss’ status displays

g remain unaffected.

3.10 Delete measured data

You can delete measured data in a set time range in the database. Doing this, the
characteristic values (i.e. trend data) and the time signals recorded during that
period of time are deleted. To delete data follow the sequence below:

o Left-click the element in the configuration tree, starting from which you want to
delete the data. E.g. select one machine. All data relating to the measuring
points of this machine are deleted for the selected time range.

e Click on System > Delete measured data or right-click on this point and select

delete measured data.

Opens the Delete measured data:

I X
V¥ Time range
Start: [20070401 =] fononoo =
End: [20070413 =] [235353 =
Mo, of days: 19 =
Help k. Abort

e Select the date and time for the start and for the end of the required period.
¢ Click on Period to deactivate the option and delete all data.
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e Click on OK to delete the data in the period selected.

Please observe that the data will be permanently deleted if you click
g' "OK" in the above window and cannot be restored! There is no way
of restoring the data!

3.11 EService

The Trendline software enables you now for the first time to utilize the services of
FAG Industrial Services GmbH easily and conveniently. Regardless of whether we
can assist you with the selection of measuring points or the analysis of the
vibration signals recorded by you, the EServices function allows you to send all
data necessary to FAG Industrial Services GmbH by e-mail.

3.11.1 Before starting

These services are economical, but will be charged for. You will find detailed
information on our website http://www.fis-services.de. Or just contact our sales
department (Tel. +49-(0)2407-9149-99 or sales@fis-services.de). If you have a
valid service contract, you can enter the contract number in the Options menu (
Extras > Options > E-mail). The contract number together with your e-mail
address are needed for identification.

3.11.2 Send data

e Select the element on the configuration tree, starting from which you would like

=
to send the data. Now, click on i.i} or on Service > EService. Now, the
following window opens.
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Trendline 3

At the top of the window you can select the time range, which you want to send the
data for. If you have unchecked the Time range checkbox all previous data will be
sent.

Enter at Data to be exported, which data shall be transferred. If no data can be
sent via this selection anymore, i.e. if you want to send alarms only, but no alarms
are in the selection, the OK button will be disabled.

Click on OK now to send the data. Depending on your e-mail settings the data
are transferred immediately or they are copied into an Outlook mail, which you

will have to send manually.

3.12 Create reports

The Trendline software offers the following report types:

The measurement report/ 91 provides a comprehensive overview of the
measured values for the sensors defined in the configuration in tabular and
graphic form.

You can use the alarm report/100| to create an overview of preliminary and main
alarms that have accumulated to date for freely selectable elements in your
configuration.

The route report/102] presents all measuring points and corresponding
measurement signals for a given route in the form of checklists. You can
systematically and reliably "work through" the measuring point of a route with
the aid of the route report.

The balancing report/1021 provides you with a clear overview of balancing
measurements carried out for one element of your configuration.

The run up/coast down report/104) creates an overview of the run up/coast down
configuration settings and the associated amplitude/phase diagrams.
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Also see report options| 111,

3.12.1 Measurement report

To create a measuring report click on Measurement report in the Service menu.
The Configure the report window opens.

Conigure therrport |
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You can carry out the following in this window:

e Select which measuring points from the configuration should be displayed;
e Specify the scope and content of the report;

e Save the report configuration or load a previously saved configuration.

Select measuring points

Trendline displays all available measuring point configurations in the left-hand area
of the configuration window.
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e Select individual measuring points to display the corresponding measured
values in the report.
.
e Click on i-#= to select all measuring points.
- -
e Click on -5 to delete the selection.

Scope and content

You can specify the settings for the scope and content of the measuring report in
the right-hand area of the configuration window:

Specifying a report time range

¢ Select the Time range option to define the limits for the report period.

M Time range

Start: |20070401 =] [omomoo =
End: [z0070413 =] [1m21:33 =
Mo, of days; 19 =

e Enter the start and end time. Alternatively, you can enter the end time and
specify the duration in whole days in the No. of days input field. In the latter
case the start time is automatically determined.

Alarm selection

Pre-alarms and main alarms can be presented either separately or jointly in the
report.

¢ Click on Report all to select all alarms or, to select individual alarm types, click
on Report alarms or Report pre-alarms.

Alarm zelection

v Report all ¥ Report alams ¥ | Beport pre-alarms

Select characteristic values

e Select which characteristic values should be displayed from the Char. values
area.
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v Show result table

e Click on Show trends to create a trend graphic that presents the measured
values for the period specified.

e Click on Selected to display only a selection of available characteristic values
and select the required characteristic values from the list.

¢ You can use the Show table of results option to instruct Trendline to create a
table containing the measured values.

Select time signal / FFT

In the Time signal / FFT area you can specify which time signals are output and
also whether their corresponding frequencies should be displayed in the report.

Timeszignal / FFT

¥ Timesignal v FFT
o A " Selected
Yelocity

Acceleration
Demodulation

[v Only last timesignal / FFT

¢ Click on Time signal or FFT to activate the corresponding display.

e Click on Selected to display only a selection of available signals and select the
required signals from the list.

e Click on Last time signal / FFT only to output only the last signals saved in
each case. All previous measurements will be ignored.
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Display additional information
The following options can be selected in the Additional information area:

e Show measuring point pictures to include the pictures inserted in the
measuring point configuration ' 457 ;

e Show measuring point comments to include the comments entered in the
measuring point configuration| 45

e Show cover sheet to output a cover sheet.

Additional info
[T Show measure point pictures [v Show cover sheet

v Show meazure point comments

Save / load report settings
You can save the report settings for use at a later date.

| = H & X

e To do this click on the diskette symbol. The Insert configuration name window
opens.

e Enter the name of the configuration to be saved in the Configuration name
input field. If this name already exists you can either overwrite the existing
configuration or cancel the procedure.

Create report

Click on Preview to generate the report. Trendline outputs a warning if your
chosen settings will cause a substantial report to be generated accompanied by a
time-consuming calculation.

'j With this configuration, up to 30 pages must be generated. Do wou wank to lek the report produce nevertheless?
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You still have the option of canceling the operation at this stage in order to reduce
the report period or the quantity of data that will be output.

You can view the measuring report on-screen or print it out via the Measuring
report window. You can use the toolbar to control the screen display:

Yigm I Fercent adjustable j Fercent IEE: j 4 ¢ o ob &h

e Tne dwomlay oile yav Pe deduved v View. Select Percentage adjustment to
enter a zoom factor expressed as a percentage in the Percentage input field.

¢ You can navigate forwards or backwards through the report and also jump to the
start or end of the report using the arrow buttons.

o Click on & to print out the report.

3.12.2 Alarm Report

You have the option of displaying main alarms and pre-alarms in an alarm report
using the Trendline software.
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e To do this, select the element in the configuration tree from which you wish to
create the report.
H3
e Click on Service > Alarm report or click on &2 in the Toolbar| 33",

Select report time range - spind A front rad

MV Time rahge

Start date: I2I:|I:|?-El4-|:|1 TI End date: IEEII:I?-EIJ,JEI vI Mo, of days: 19 -

Help |

Select the Time range option to define the limits for the report period. Enter the
start and end time. Alternatively, you can enter the end time and specify the
duration in whole days in the Number of days input field. In the latter case the
start time is automatically determined.

Deactivate the Time range option to incorporate all available data in the report.

Click on OK to create the alarm report.

You can view the measuring report on-screen or print it out via the Alarm report
window.

The alarm report incorporates sections for main alarms and pre-alarms. All
characteristic values for a given measuring point will be displayed in the main
alarm section where at least one main alarm exists for this measuring point.
Where a main alarm exists for a characteristic value this is displayed in bold and if
a pre-alarm exists this is displayed in italics. If neither a main alarm nor pre-alarm
exists the relevant characteristic value is displayed in grey.

Where a main alarm exists for a characteristic value, the main alarm
Q/ threshold is used as reference for the exceeding value, and where a
pre-alarm exists the pre-alarm threshold is used as reference.

You can use the toolbar to control the screen display:

Wiz

‘F‘ercent |95—j‘#+#+‘§|

e The display size can be defined in View. Select Percentage adjustment to
enter a zoom factor expressed as a percentage in the Percentage input field.

¢ You can navigate forwards or backwards through the report and also jump to the
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start or end of the report using the arrow buttons.
e Click on = to print out the report.

3.12.3 Route report

You can use the route report to create an overview of settings and measuring
points for a specific route.

e Click on Route report in the Service menu and select a route that has been
defined in your configuration.

Print route

e Click on OK. The Route report window opens.

You can use the toolbar to control the screen display:

Wi

‘F‘ercent |35—j‘#¢-}+‘§|

e The display size can be defined in View. Select Percent adjustable to enter a
zoom factor expressed as a percentage in the Percent input field.

¢ You can navigate forwards or backwards through the report and also jump to the
start or end of the report using the arrow buttons.

e Click on = to print out the report.
3.12.4 Balancing report

To create a balancing report click on an element of your system structure then
click on Balancing report in the Service menu. The Configure report properties
window opens.

102



Trendline 3

Confiqure report properties

v Piint balancing configurations v Print measurement details
v Planes [ Print measurement coefficients
v Piint senzor positions [v Print measurement results

Help | ] Abort

Print balancing configurations: If this option is selected the settings for the
balancing configuration| 537 are printed with the report.

Print planes: information on the planes is included in the report.

Print sensor positions: information on the trigger sensor and vibration sensors
is included in the report.

Print measurement details: the individual steps of the balancing measurement,
the amplitude and phase of the vibration, the time of measurement, the
rotational speed and information on weights used are documented in the report.

Print measurement coefficients: The coefficients determined during balancing
are also displayed.

Print measurement results: the start and end of the imbalance amplitude, the
imbalance reduction and information on the balance weights determined are
included.

Click on OK. The Route report window opens.

You can use the toolbar to control the screen display:

LHT=

Fercent IEIE jl 4 4 & ob = I

e The display size can be defined in View. Select Percent adjustable to enter a

zoom factor expressed as a percentage in the Percent input field.

¢ You can navigate forwards or backwards through the report and also jump to the

start or end of the report using the arrow buttons.
e Click on % to print out the report.

See also

Add balancing configuration 537
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3.12.5 Creating a run up/coast down report

To create a run up/coast down report, select a run up/coast down configuration in
your system tree and click Run up/coast down report in the Service menu. This
displays the Run up/coast down configuration.

Configure report properties for run up f coast down

¥ Piint configuration of run up # coast down [¥ Print graphics for run up / coast down
v Print acceleration sensor settings
[ Print tigger settings
v Print zettings of mn up / coast down
[ Print frequency zettings

[ Print expert settings

¥ Time range

Start: |20070401 x| [1m43m =
End: |2007.0419 =] [1543m 0 =
Mo, af days: 19 =

Selecting data for the report

e Print configuration of run up / coast down: If this option is enabled, all
amplitude/phase diagram and run up/coast down test settings are also printed.
To hide/show specific sections of this configuration| 61, please use the other
options.

e Print run up/coast down diagrams: The run up/coast down measured datal 63"
available for the measuring point are also printed as an amplitude/phase
diagram, including any frequency bands.

Specifying a report time range
¢ Select the Time range option to define the limits for the report period.
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V' Time range

Start [zo07.04m =] [1543H1 =
End: [z007.0419 =] [1m4zm1 0 =
Mo, af days: 19 -

e Enter the start and end time. Alternatively, you can enter the end time and
specify the duration in whole days in the No. of days input field. In the latter
case the start time is automatically determined.

3.13 Importing and exporting data

3.13.1 Importing data from a Trendline 3.x database

You can import configurations and measuring data from a Trendline 3.x database
using the following procedure: Use the following sequence:

e Click on File > Import > Trendline 3.x data.

e Select the file to be imported (*.tr3) and click OK.

3.13.2 Export wizard

Flexible selection of export data is possible using the export wizard. You can
include pictures and comments, specify a period for the data to be exported or
export only selected data objects, for example.

To export data proceed as follows:

e Click on Export > Export wizard in the File menu. This launches the export
wizard which guides you step-by-step through the export function.

=
e First select an export file. To do so, click Filename and enter a file name.

e Next decide whether pictures and comments should also be exported. Note
that pictures in particular can increase file size dramatically. Make sure that
there is enough memory available.

¢ Now decide whether Trendline should export All Data or just a Selection. If you
select All data the exported file may be very large.

¢ Finally, you can limit the data to be exported by selecting Not yet exported data
only and/or Only meas. positions with alarm conditons.

¢ Click on Finish to apply your settings and create the export file.
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3.13.3 Export a measuring point

You can export the data assigned to an individual measuring point to a text file to
edit them with another program. The Trendline software saves the export files in
one or several files in CSV format ("comma separated values"), i.e. data on a line
are separated by commas. You can open files in CSV format with any common
spreadsheet software to get a clear overview of the data in a table.

In addition to the measuring point data proper, the Trendline software also saves a
file called "Versioninfo.csv" containing details on the program version and the
database used.

Proceed as follows to save a measuring point:

Click on the measuring point in the configuration tree.

Click on File > Export > Measuring Point.

Select the directory where you want to save the file and enter a file name. The
program automatically adds the .csv ("comma separated variables") extension.

Click on OK to export the data.

Below is a description of the contents of the export file depending on the type of
measuring point.

Measuring point from a Cm configuration

If you export a measuring point from a CM configuration, the Trendline software
saves a general export file with details of the configuration and other files with the

time signals.
The general export file contains a line for each measurement containing the
following:

Heading Contents

idx Measurement identification number.

State Alarm Status: 0 — no alarm, 1 — pre-alarm, 2 — main alarm

Timestamp Measurement timestamp.

Velocity Export file with velocity time signal (the signal is an acceleration signal, see

alsoTime signals[211).

Acceleration Export file with the acceleration time signal.

Demodulation Export file with the demodulation time signal.

Data x Characteristic value measured

Name x Name of characteristic value

Type x Type of characteristic value | 15",

Prealarm x Pre-alarm threshold in % of the main alarm threshold.
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Heading

Contents

Alarm x

Main alarm threshold.

Measuring point

Name of measuring point

export_timestamp

Export time

Comment

Measuring point comment

used_revolution

The rotational speed input by the user after the measurement. This value is
identical to the rotational speed actually measured until it is changed.

config_revolution_delta

The maximum rotational speed deviation set in the measuring point
configuration

config_revolution

The rotational speed set in the measuring point configuration.

revolution

The rotational speed measured on the Detector.

viewer_config_x

Configuration data for the FIS-Viewer.

e The entries "Name", "Type", "Prealarm”, "Alarm" and "Data" are created for
every existing characteristic value, i.e. a maximum of four times. x designates
the serial number of the characteristic value.

e The entries "Velocity", "Acceleration" and "Demodulation" refer to other CSV
files with the data of the measured time signals.

The time signal files are structured as follows:

e The file header contains the data.

Heading

Contents

idx

Measurement identification number.

Internal Number

Internal number identifying the measuring point.

Timestamp Time stamp .

ValueUnit Detector channel (velocity, acceleration or demodulation) of the
measurement, as a figure and in plain text.

length Column 1: Internal control index, Column 2: Number of FFT lines set in the
configuration.

Ampl Amplifier setting used in the measurement. Amplification factor = 2AmP!,
where 0 means amplification factor 1, 6 amplification factor 64. This constant
is already considered in the time signal values.

Scale factor Scale factor for the measurement. This has been worked into the time signal
value already just as well.

Sample rate Samples per Second.

Rotational speed

The rotational speed measured on the Detector.
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Heading Contents

GUID Global unique identification number of the measuring point.
Timesignal count / Number of time signals and FFT values

FFT count

e The time signals and FFT values are stored in four columns under the header.

o Column 1 contains the time of the measurement in seconds from the start of
the time signal, column 2 contains the time signal measurement.

o Column 3 contains the frequencies of the FFT in Hz, column 4 the amplitudes.

Measuring point from a balancing configuration

If you export a measuring point from a balancing configuration, the Trendline
software saves a general export file with details on the configuration, the balancing
jobs and the weights. In addition, the program creates one file per balancing step
("Data File<n>.csv") containing the associated sensor data.

The general export file contains the following details:

Heading Contents
Data File Export file with the sensor data.

Balancing measurepoint | Name of measuring point

Job Number Number of the balancing job.
App. weight 1 amplitude | Amplitude of the weight used in plane 1.
App. weight 1 angle Position angle of the weight used in plane 1.

App. weight 2 amplitude Amplitude of the weight used in plane 2.

App. weight 2 angle Position angle of the weight used in plane 2.
comment Measurement comment.

step_type_text Type of balancing step (reference run, trial run, etc.).
remove_weights_text Indicates what weights were removed.

The sensor data files contain the following details:

Heading Contents

Sensor position Name of sensor position.

Amp. Coeff. plane 1 Amplitude of the coefficients in plane 1.
Ph. Coeff. plane 1 Angle of the coefficients in plane 1.
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Heading

Contents

Amp. Coeff. plane 2

Amplitude of the coefficients in plane 2.

Ph. Coeff. plane 2

Angle of the coefficients in plane 2.

Speed Rotational speed.
Amplitude Amplitude of the vibration.
Phase Phase of the vibration.
Timestamp Measurement timestamp.
export_timestamp Export time

Measuring point from a run up/coast down configuration

If you export a Measuring point from a balancing configuration, the Trendline
software saves a file containing the values of the amplitude/phase diagram in

addition to a general export file with details of the configuration.

The general export file contains the following details:

Heading

Contents

id

[dentification number

Run up / cost down
measuring point

Name of measuring point

timestamp

Measurement timestamp

Comment

Measurement comment

No. data points

Number of values measured in run up/coast down.

bodeplot data file

File with values from the amplitude/phase diagram

export timestamp

Export time

The file with the amplitude/phase diagram values contains the following details for

each diagram value:

Heading Contents
Amplitude Vibration amplitude
Phase Phase of the vibration
Frequency Rotational speed
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3.13.4 Import and export between different workstations

In Trendline every measuring point in the database has a unique number, the so-
called GUID (Global Unique Identifier). This number is only stored in the database
and is not displayed in the software. With it, configurations and measuring points
are unambiguous over several workstations. Consequently when exporting data
from one workstation and re importing it, it will be automatically recognized and
sorted in correctly. This will be explained by means of an example.

On a central location (headquarters) all measured data is analyzed. However it is
measured on several locations. This exports a part of the configuration containing
the measuring points for location B and imports it to a computer at location B in
Trendline. The data are imported into the Detector, the measuring points are
measured, and the measured data are read back into the computer. The
configuration is now exported from workstation B and imported into the Trendline
on the workstation in headquarters. The following graph shows the example
graphically.

load configuration

w» Detector
Workstation B

import
configurati

-

(fexport —P Location B
) ’ ‘
o Location B read measured
n import export data
Workstation A configuration config’fjration
Central database export
configuration import
import configuration load configuration
configuration Workstation C ] onto Detector
Location C Detector
export read measured Location C

configuration
data

Import and export between different workstations

3.14 Program settings
3.14.1 General

e Click on Options in the Tools menu then click on General in the Options
window.

Name

e Click on Name to specify how new configurations, sections, routes, etc. should
be named when you click on New entry or New sub-entry.

Please note that balancing plane identifiers on the Detector is
g/ limited to four characters.
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Language

e Click on the Language selection box and select the dialogue language for the
Trendline software.

System of units setting

In this section you can set the units system for the measured values listed.
The following options are available:

e Standard Sl units,

e Standard US units or

e User-defined units. When making these settings you can assign units to each
measured variable individually from the range of available units.

3.14.2 Database

e Click on Options in the Tools menu then click on Database > History in the
Options window.

You can specify the number of entries the list of most recently opened databases
should contain at the Number field in the File menu. The default value is 10.

3.14.3 Report

Click on Options in the Tools menu then click on Report > Pictures in the
Options window.

You can specify what pictures to print on a Trendline report| 95 cover sheet here.
The pictures are scaled automatically for the printout.

If you select a picture in the Vignette area this is printed at the bottom of the
cover sheet on the left.

You can specify which picture is to be printed in the center of the cover sheet in
the Large picture area.

In the Logo section you can specify what logo to print on the top right of all pages
except for the cover sheet.

¢ Click Edit and select the desired graphics file. Trendline displays a preview and
the file name.
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e To remove a graphic file again click on Delete.

3.14.4 E-mail

In order for Trendline to be able to send data by e-mail (see also EServicel 947 or
Automatic export%), you must enter the name of the sender, the recipient and
the contract number.

e Go to the Tools menu and click on Options then click on E-mail >
Configuration in the Options window.

e Enter your own e-mail address in From.

e Enter the e-mail address specified in the contract (e.g. nemo@fis-services.de) in
To and the number of your service contract in Contract number.

e You can enter a text in the Comment field which will appear by default when the
e-mail window is opened.

Additional settings

e Click Configure to set the protocol for Trendline to send e-mails. Trendline
supports Microsoft Outlook, MAPI or SMTP. To obtain the correct settings
consult your network administrator.
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e To test whether e-mails are being transferred correctly click on Test connection

3.14.5 Data view

To edit program settings for data display (Viewer), in the Tools menu click
Options, then in the Options window click Data view > Configuration >
Configure. This opens the Configuration window of the Viewer.

For further details, refer to Viewer section "Program settings /160",

3.14.6 Automatic export

The Trendline software can automatically export data from CM measurements|182]
as soon as the Detector receives them. It can automatically send the exported
data by e-mail or save them to a compressed ZIP file.

e Click on Options in the Tools menu then click on Automatic export in the
Options window.

E-mail export

¢ Click on Automatic to switch on the automatic export and subsequent dispatch
by e-mail.

e Click on Only on alarms to carry out the automatic e-mail export only if the data
received from the Detector contains alarms.

File export
¢ Click on Automatic to instruct the software to export data automatically to a file.

e Click on Only on alarms to carry out the automatic file export only if the data
received from the Detector contains alarms.

e In Default file name (.tr3) enter a name for the ZIP file to be saved. The file
name must include the ".zip" extension.

o Select the storage location for the exported file at Default directory.
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4 The FIS-Viewer

4.1 The working interface
4.1.1 Interface areas

The toolbar/1151 contains various tools which can be used to arrange the
diagrams and display/remove the tool area and diagram information bar as well
as other tools which can be used to export measurement data, display the
corresponding configuration for the data set selected and create a measurement
report.

You will find a range of navigation tools in the tools|1161 working area which can
be used to modify the way in which the diagrams are presented and also find a
number of different cursor tools for carrying out fault analyses. The choice of
tools which can be used varies according to the type of diagrams displayed
(FFTs, time signals or trend data).

The main area of the working interface contains the diagram[122) and the cursor
and measuring information|123) area in which the corresponding values for the
cursor selected are displayed.

You will find additional information in the diagram information bar!1251 (on
measurement data for example) depending on the diagram type displayed. You
can use the tools in this working area to do the following:

o enter comments into the diagram

o select frequency bands with FFTs in order to determine characteristic values
for the fault analysis

o determine the maximum, harmonic or sideband values from the diagram
depending on the cursor type

The diagram information bar area for each diagram can be displayed or removed
as required and can be used to increase the diagram area.
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4.1.2 Toolbar
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You can use the Arrange windows horizontally button to arrange open
windows vertically above one another in the working area of the Viewer.

You can use the Cascade windows button to arrange open windows so they
overlap in the working area of the Viewer.

You can use the Full screen display of current diagram button to fill the
entire screen of the Viewer working area with the current diagram selected.

You can use the Arrange minimized windows button to arrange minimized
windows horizontally from left to right in the working area of the Viewer.

If the Arrange diagrams automatically button is activated the size of the
diagram always adjusts automatically to fit the available working area (when the tool
area is displayed or removed, for example).

You can view a list of the windows that are currently open and make your selection
using the Display diagram list button. The selected diagrams are arranged
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horizontally and the rest of the diagrams are minimized.

You can use the Display tool area button to display/remove the tool area in the
working interface of the Viewer.

=4

You can display/remove the information bars of all open diagrams using the Display
diagram information bars.

G

You can open a list of the windows that are currently open using the Copy
selected diagrams to clipboard button. From this list you can also select
whether the accompanying information text should be copied together with the
diagram and define the size of the diagram. The diagrams selected are copied
together to the clipboard as one graphic object.

o

You can use the button Show time signals to only show the time
signal windows. All other windows will be minimized.

3

ﬂh You can use the button Show FFT to only show the FFT windows. All
other windows will be minimized.
lf.. You can use the Show all diagrams to maximize all diagram
windows.
4.1.3 Tools

The tools area contains a range of adjustments which you can use to set the
display area for the diagrams. A range of different individually tailored tools is
available depending on the type of data set displayed (time signals, FFT or trend
data). These tools can be used for example to do the following:

1

display/remove individual signals within a series of signals when working with
trend data,

modify the scale of measuring ranges,
integrate the velocity and displacement from the acceleration,

modify the display of the measuring range to suit your individual requirements
and

navigate through a diagram easily using the navigation overview.
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List of the tools available in conjunction with the corresponding diagram
type displayed.

Tool Time FFT Trend
signal data

Automatic scaling[ 1281 v v v
Manual scaling[ 128 v v v
Logarithmic display of axes [1281 4 v v
Integration of Y axis [128) v

Free zoom [132 v v v
Horizontal zoom [132) v v v
Vertical zoom 132 v v v
Keyboard zoom 132 v v v
Base cursor v v v
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Tool Time FFT Trend
signal data

Difference cursor v v v
RMS/AMV cursor v v

Harmonic cursor v

Sideband cursor 4

HS cursor v

Revolutions cursor v 4

Positioning of base cursor v v v
Modify cursor properties v v v
Copy to clipboard v v v
Modify coordinates of axes v v v

Zoom tools

In order to optimise the display you can enlarge any part of the diagram using the
various zoom tools. You can use one of the predefined zoom tools for this or
define the zoom area numerically via a dialogue window.

N Free zoom F3

) N Horizonkal zoom Fio |

N Yertical zaam Fi1
I.”uf’ Kevboard zoom  F12

Zoom tools
Tool Sym- | Description
bol
Free zoom N You can use the Free zoom tool to enlarge any given rectangular area on
the X and Y axis within a diagram.
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Tool Sym- | Description
bol
Horizontal l You can enlarge any part of a diagram in a horizontal direction using the
zoom Horizontal zoom tool. The range of values and scaling of the Y axis remain
unchanged.
Vertical H You can enlarge an area inside a diagram in a vertical direction using the
zoom Vertical zoom tool. The range of values and scaling of the X axis remain
unchanged.
Keyboard ‘J You can use the Keyboard zoom feature to enlarge an area of the diagram
zoom using the keyboard instead of the mouse.

Specifying zoom selection in dialogue window

In addition to using the various zoom tools you can also specify the zoom selection
via a dialogue window. To open the dialogue window which is currently active click
on the zoom tool symbol. The boundary values can be entered in the numeric input
fields for the zoom selection to be displayed.

FIS rviewer il
Zoom slice

#-aiz [Hz]

b innirLar; b amirnan;

|ELEIEIIII |2,E|E|E| Reset values |
-amiz [mg]

b innirar; b airnan;

II:LEIEII:I I'IT-",._'"B'I Reszet values |

k. Ahart

Cursor tools

You can specify the values from a diagram to be used for an analysis with the
cursor tools. Depending on the type of diagram which has been opened

119



¥ fls_

appropriate cursor tools are made available which can be used to obtain individual
measuring and characteristic values directly from the diagram.

Toals A |

N -5 3 e
L m Base cursor Fz

i‘* Difference cursaor F3
%I* RIS AMYCursor F4

Tj?t Harmaonics cursar F5
ﬁ" Side band cursor Fé
fﬂ"f! HS cursor F7
@ Revolutions cursor FS

Information on the current cursor is displayed above the diagram. These value
fields and the cursor itself can be removed/displayed by clicking on the cursor tool
symbol that is currently active.

leis raver (F1 | [ Dllerests cumar | 5 MRS

Rt N
Cursor information for a
RMS/AVG cursor
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Tool

Sym-
bol

Description

Base cursor
(FFT, Time signals,

You can use the base cursor to determine the measured values on
the X and Y axis of a measuring point.

Trend data)
Difference cursor '-.‘-"* You can use the difference cursor to calculate the difference
. . dki. | between two measured values.
(FFT, Time signals,
Trend data)
RMS/AMV cursor =, You can calculate the RMS (root mean square/effective value) and
i the AMV (arithmetic average) between two measuring points using

(FFT, Time signals)

the RMS/AMV cursor.

Harmonic cursor
(FFT)

You can use the harmonic cursor to determine measured values at
points in the diagram where harmonics (multiples of the basic
frequency) are likely to occur.

Sideband cursor o You can use the sideband cursor to determine additional measured
(FFT) BL¥ | values in definable sidebands starting from the base cursor.

HS cursor I,a| ] | The HS cursor (Harmonic with Sidebands) combines both cursor
(FFT) Lf. types described above which means that both the harmonics and

their sidebands will be displayed.

Revolutions cursor
(FFT, Time signals

The revolutions cursor marks the frequency that is assigned to a
specific speed with a line. The value for this speed is calculated as
follows:

”[mlﬂ 60 - flrE]

A cursor can only be placed at a measuring point that exists. If you

i

Additional tools

click on a position in the diagram where no measured value exists the
cursor automatically jumps to the nearest existing measuring point.

In addition to the zoom and cursor tools you can use a range of further tools to
change the manner in which signals or cursors are displayed and transfer data to
other programs via the clipboard.

cursor

Tool Sym- | Description
bol
Positioning of base W) Places the base cursor at a point in the diagram specified via
x

numeric input. The base cursor jumps to the measuring point nearest
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the value entered.

Opens the cursor properties dialogue window where you can change
the properties of the cursor currently used.

Cursor properties

i

i
¥

Clipboard Copies an image of the current diagram view into the clipboard (

further information 151,

Changes the display of minimum/maximum values for the X and Y

Modify coordinates of
axis (further information 151,

axes

F_’

4.1.4 Diagram display
The diagram area shows the FFT, time signals and trend data diagrams. You can

specify the desired zoom area inside the diagrams and adjust the position of the
cursor using the mouse or keyboard.

A description of the various zoom and cursor types is provided at
g Cursor and measuring information 1231,
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